
User’s Guide 

 

RxView R 18 

 

for Windows 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Publication no. 920.098 Pub. Rev. 18 



 

 

ii 

SOFTWARE LICENSE AGREEMENT 

Grant of license 

Rasterex grants you the right to install the Software on one (1) computer or one (1) 
network server at any one time. Rasterex also grants you the right for one (1) User (or 
in the case of a Network License, the number of Users stated on the purchase 
agreement) to activate the Software at any one time. This license is an overriding 
condition, whether or not further mechanical or electronic measures are used to prevent 
more than the purchased number of Users activating the Software at any one time. 

Copyright 

The Software is owned by Rasterex, and is protected under international copyright 
laws. You must therefore treat the Software as you would any other copyrighted 
material, except that you may either (a) make one copy of the Software solely for 
backup or archival purpose, or (b) transfer the Software to a single hard disk provided 
you keep the original solely for backup or archival purposes. You may not copy the 
written materials accompanying the Software. 

Terms 

This license is effective from your date of purchase and shall remain in force until 
terminated. You may terminate the license and this agreement at any time by 
destroying the Software and its documentation, together with all copies in any form. 
Rasterex may terminate this agreement if you fail to comply with any of the terms and 
conditions of it. Upon any termination of this license, you agree to destroy the Software 
and its documentation, together with all copies, modifications or portions of them in any 
form. You must provide us, on our request, written certification of such destruction. 

Limited warranty 

Rasterex warrants that, for a period of ninety (90) days of normal use from the date of 
original purchase, the CDs on which the Software is recorded will be free from defects 
in materials and faulty workmanship, and the Software will function substantially as 
described in the enclosed program documentation. Except for the aforesaid warranty, 
all products delivered pursuant to this agreement are delivered on an ”as is” basis and 
Rasterex, its distributors and dealers, expressly disclaim any and all other warranties, 
expressed or implied, including, without limitation, implied warranties or conditions of 
merchantable quality or fitness for a particular purpose. 

Limitation on liability 

Rasterex’s entire liability, and your exclusive remedy for any breach of the limited ninety 
(90) day warranty described above, shall be the replacement of any CD or program 
documentation not meeting with the warranty, that is returned to Rasterex or to one of 
its distributors or authorized dealers together with a copy of your paid receipt. 

Under no circumstances shall Rasterex, its distributors or dealers, be liable for lost 
profits, data or information of any kind, or for consequential, special, indirect, incidental, 
punitive or other damages that may arise through use of the product licensed 
hereunder. 
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Governing law 

This Software license agreement is governed by the laws of Norway. 

Disclaimer 

Rasterex makes no representations or warranties regarding the contents of this guide, 
and specifically disclaims any implied warranties of merchantability of fitness for any 
particular purpose. Furthermore, Rasterex reserves the right to revise this publication 
and to make changes from time to time in the contents without an obligation by 
Rasterex to notify any person of such revision changes. 

Trademarks 
Rasterex Registered trademark of Rasterex 

RimEngine Registered trademark of Rasterex 

RimServer Registered trademark of Rasterex 

RxAutoImage Registered trademark of Rasterex 

RxBatchManager Registered trademark of Rasterex 

RxCapture Registered trademark of Rasterex 

RxCDManager Registered trademark of Rasterex 

RxFilter Registered trademark of Rasterex 

RxHighlight Registered trademark of Rasterex 

RxHighX Registered trademark of Rasterex 

RxIndex Registered trademark of Rasterex 

RxLock Registered trademark of Rasterex 

RxQuickView Registered trademark of Rasterex 

RxRaster Registered trademark of Rasterex 

RxReproScan Registered trademark of Rasterex 

RxSpotlight Registered trademark of Rasterex 

RxVectory Registered trademark of Rasterex 

RxView Registered trademark of Rasterex 

RxViewX Registered trademark of Rasterex 

ADI Registered trademark of Autodesk Inc. 

ADS Registered trademark of Autodesk Inc. 

AutoCAD Registered trademark of Autodesk Inc. 

AutoCAD LT Registered trademark of Autodesk Inc. 

Microsoft Windows Registered trademark of Microsoft Corp. 

Microsoft Windows NT Registered trademark of Microsoft Corp. 

Microsoft Windows XP Registered trademark of Microsoft Corp. 

Microsoft Windows Vista Registered trademark of Microsoft Corp. 

All other brand and product names used in this product are trademarks of their 
respective companies. 
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Chapter 1 Introduction 

Welcome to RxHighlight and RxView 

RxView come in two different main versions Full and CAD both with 
different file format support. Functions that are not relevant to all 
versions are noted as such in this user guide. 

 

RxHighlight has all the functionality of RxView, with additional markup, 
security and file conversion features. The programs run on all 
Windows platforms from Windows Vista onwards. 

RxView 

RxView is a powerful explorer and viewer that can be used to view and 
print the following file format categories: 

Documents 

Spreadsheets 

Drawings 

Raster files 

Pictures 

New and improved filters are continually under development. 

CAD version support mainly CAD formats. 

Viewing functionality 

Files can be loaded and viewed from local or network drives, and 
intranet and Internet addresses. Interpretation of files is fast and 
precise. Multiple files can be viewed simultaneously in separate 
windows, and these windows can be cascaded, tiled and split as 
required. Viewing is enhanced with functions including fast zoom, pan, 
page, file overlay, file compare and markup. 

Printing and plotting 

A powerful printing and plotting engine allows RxView R18 to be used 
as a printing station in technical offices. All Windows based printers 
and plotters are supported. 
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3D Files 

The standard installation includes 3D format support for STL and 
AutoCAD. A separate installation exist for additional 3D formats, 
including Catia, SolidWorks, IFC, etc. 3D file formats are generally 
subject to separate licensing agreements as many of the file formats 
are supplied by third-party developers. Contact your supplier for details 
and prices. 

Administration and Permissions 

User Profiles are set up to control creation, viewing, editing and 
deleting of markups, linking, and permissions for operations such as 
executing applications and printing. This powerful administrative tool 
gives control of user rights in design offices, technical environments 
and Electronic Document Management systems (EDM). 

RxHighlight  

Batch print and conversion 

Using RxHighlight you can batch process a large number of files and 
have them printed or converted to another supported save file format. 

Convert 

Using RxHighlight you can save the active vector drawing to a different 
vector file or raster format. The file format (i.e. file type) can be 
selected from a list of the available formats. Any sub type can be 
selected using the options button if available. 

When saving to a raster format you need to specify number of colors, 
compression, size and DPI of the target format in a separate dialog 
that appear after you click the save button. 

Markup 

RxHighlight enables you to annotate file contents by adding graphics 
and text into markup layers. Markups are stored in separate vector 
files. Files can have multiple markup layers created by separate users. 

Linking 

RxHighlight also allows you to link related files using the hyperlink 
property of any markup entity or using the link function that creates 
buttons on top of the viewed file that link the file to other files. Clicking 
a link button, or a markup entity with the hyperlink property set, loads 
the linked file. 
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Workflow Integration 

TDM / EDM (Technical and Electronic Document Management) 
systems can use RxView and RxHighlight as viewing and markup 
tools controlled by RxIndex or another database. 

File Security 

Markup and overlay file formats are proprietary to Rasterex. This 
guarantees security considerations. 
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Conventions 

In this document, the following text conventions apply: 
 
Bold text 1. Important notes. 

Italic text 1. Menu names. 

2. Software button texts. 

3. Dialog texts. 

4. Variables. 

UPPER CASE 1. Commands. 

2. Keyboard legends. 

3. Keys to be typed on the keyboard. 

4. File and folder names unless case-sensitive. 

5. Profile parameters. 

Courier 8pt 1. Application code to be typed in by the user. 

 

In this document, Ribbon > Panel is used to denote the route or chain 
of commands used to arrive at a particular dialog box, parameter or 
result. 

Support 

If you experience difficulties using this product, or if you have 
questions concerning this or other Rasterex products, contact your 
local supplier. Your local supplier’s name and contact information 
should be printed on the box in which this product was supplied. A list 
of the various national distributors is also available on the Distributors 
tab of Rasterex’ Home page, located at: 

 

http://www.rasterex.com 

 

 

http://www.rasterex.com/
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Chapter 2 Installation 

 

Note  This program runs on Microsoft Windows-based platforms, 
Windows 2003 Server, Windows 2008 Server, Windows 2012, 
Windows Vista, Windows 7, Windows 8 and Windows 10. 

2.1 Requirements 
RxView R18 minimum requirements: 

Pentium dual core or equivalent. 

Minimum 2GB RAM (more RAM allows more open files). 

300 MB of free hard disk space. 

RxView runs in trial mode for 14 days. There are no limitations in trial 
mode. A valid license key can be bought and added at any time. 

2.2 Installation 
Select the installation for RxView and run using either enter or double 
click. If you are using the msi  installation we recommend that you run 
this from a command window that is elevated. i.e. running “As 
Administrator”. 

1. Follow the instructions.  

The installation program is straightforward and registers the program 
in the Windows registry. Use the Add/Remove Program dialog if you 
need to remove RxView. 

 

2.3 Network License Keys 
If you are installing RxView as a multi-user program on a network and 
you are using a network license, you need to install the Rasterex 
License Server on a server or workstation in the network. RxView 
needs to locate the License server or single license file in order to run. 
See the Rasterex License Server guide. 

2.4 Documentation 
This user’s guide is included in your installation as a PDF file.  
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Chapter 3 Getting Started 

3.1 Starting RxView for the first time. 
You should run RxView “As Administrator” the first time, to enable the 
license information being correctly entered into registry. 

 

When you start RxView the first time you will be presented with the 
following dialog. 

 

Figure 1 License Notification 

Select the Option I have bought a license and want to unlock the trial 
version now. Radio button. Then Click on the Continue button. 

 

The following dialog FlexLM License Finder should appear. If you have 
a single license you should select Specify the License File radio 
button. If you have set up a license server you should select the 
Specify the License Server radio button. Then click the Next button. 
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Figure 2 FlexLM License Finder. 

Specify the License File option will bring up this dialog. Click on the 
Browse button and select the license file you received from Rasterex. 

 

Figure 3 FlexLM License Finder - File 
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Specify the License Server option will bring up this dialog. Enter the 
name of the Machine where the FlexLM service is running or use the 
IP address to that machine, then click the Next button 

 

Figure 4 FlexLM License Finder – Server 

If the connection to the License server is successful you should be 
able to choose from the available license types on that server. The 
available options will depend on your license. Select the license type 
you intend to use and click OK. 

 

Figure 5 License Finder Selection Dialog. 



 

 

21 

3.2 Overview 
This chapter describes the various parts of the RxView window and 
the most important features of RxView. You will find detailed 
descriptions of dialog boxes, toolbars and procedures in later 
chapters. Use any of the supplied samples to show the features, all of 
which are accessed through buttons and menus. 

3.3 Main Window 
Start RxView and the following screen or one similar appears: 

 

Figure 6 The RxView window 

As illustrated, the RxView window includes a work area, a home menu, 
function ribbons and a quick access toolbar. A status bar is placed at 
the bottom of the window. Several function panes that can be set to 
automatically hide when not in use are also available and give easy 
access to important information and functionality. 

3.4 Ribbons 
When RxView R18 is opened for the first time, the “default” screen 
layout appears. 
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Shortcut keys can be assigned to all functions. All functions can be 
also be added to the Quick Access Toolbar. 

 

3.4.1 Home Ribbon 

File operations – Open, Close, Save, Next, Previous, Pen Table and 
print operations. 

Viewing operations – Zoom, Pan, Rotate, Flip X,Flip Y. 

Page operations – Page Up, Page Down and Select Layout.  

Tools – Magnify, Bird’s Eye, Calibrate and Measure 

Find and Extract text, select and save, open in editor. 

Copy to Clipboard functions 

 

3.4.2 Markup Ribbon 

Tools – Show/hide markup, markup refresh, markup report, markup 
revision history, paste in content from the clipboard as markup, 
markup import/export, show next/search for markup text, 
Next/Previous navigation of markup linked documents, Markup layers, 
Markup users and consolidation. 

Edit – Select, line thickness, line style, markup color, markup layer, 
markup properties, draw order, hatch fill pattern, delete and marker 
setting. 

Draw – For the various markup entities available See Chapter 
RxHighlight.  

Measure – For the various markup measure tools available See 
Chapter RxHighlight. 

 

3.4.3 2D CAD Ribbon 

Tools – Background color,  Inspector, Find Attributes, List Attributes, 
Anti Alias. 

Blocks – Block Mode, Next and Previous Blocks. 
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3.4.4 3D CAD Ribbon 

Tools – Reopen as 3D, Background color, Find attributes. 

3D Mode – Orbit, Walkthrough, and spin mode. 

3D Control – Smooth rendering, Wireframe, Transparent, Explode.  

Sectioning dialog, Two point sectioning, Perspective, material. 

Parts and Blocks – Restore, Set Hidden, Set transparent, Select block 
and show Information. 

Operations for 3D files – Rotate, Perspective, Wireframe and Cross- 
Section controls. 

 

3.4.5 BIM Ribbon 

IFC Display State – Select IFC block type to display, Storey slider. 

 

3.4.6 Tools Ribbon 

Batch  – Batch print and batch convert functions. 

File – Standard operations for office formats including Word, Excel, 
and PDF, Gridlines, Thumbnails, Background color, File list, file list 
items management. 

Compare and Overlay 

Conversion 

Raster Tools – Scan new document, Add Page from scanner, Turn 
scanned page. 

Clipboard – Bitmap, Metafile and Text. 

Settings – Markup options, RxView options and Filter options. 

 

3.5 Status Bar 
The status bar is located across the bottom of the RxView window. 
This bar can contain the following information from left to right: 

X Position – Is the position of the cursor within the active file, along 
the X (horizontal) axis. 

Y Position – Is the position of the cursor within the active file, along 
the Y (vertical) axis. 
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Progress Bar – Indicates how the application is progressing through a 
process. This will be visible while the process is active, and will be 
hidden otherwise. 

Active measurement unit – You can select a measurement unit for 
the active measurement type from this drop down list. 

Set measurement unit – Opens the Filter Settings dialog where you 
can set the measurement system that will apply to all files associated 
with the same filter.  The drop down next to this button will a allow you 
to quickly set the measurement type for the active file format. Select 
between metric, imperial or custom. 

Set custom scaling – Allow you to add additional scales that can be 
accessed from the Drawing Scale drop down. 

Drawing Scale – Allow you to quickly set the scale for the currently 
active file. The scale will be relative to the selected measurement type. 

Paper Size – RxView will attempt to determine the print size of the 
current drawing or document given in standard paper sizes. If a paper 
size can not be determined the value “Unknown” will be used. 

Percent zoom – Allow you to quickly select a zoom percent factor. 
You can set a fixed zoom percent or use the zoom slider next to it. 

Snap on off – You can turn the snap function on/off by double clicking 
“Snap” on the status bar. Snap function is used to aid drawing 
operations when doing measurement and markup on vector drawings. 

Snap Settings – You can set snap points and other snap settings 
from this drop down menu. 

Ortho on off – You can turn the ortho function on/off by double 
clicking “Ortho” on the status bar. When Ortho is enabled drawing 
operations are locked to 45 degree angles when doing measurement 
and markup on vector drawings. 

User Name – the current user name is displayed on the status bar. 
This can either be the windows user (default) or any user name 
specified in the Tools->User Signature function. Right click on the user 
name to change user signature, or to see the user rights assigned to 
the current user. 

User information – Opens a dialog that display information about the 
currently active user.  
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3.6 Workspace Area 
The workspace area comprises the entire area of the screen except 
the areas covered by the ribbons, status bar, and any open workspace 
panes. 

Any number of files can be displayed simultaneously. You can 
cascade the displayed files vertically or horizontally, or tile them, and 
you can split an active file’s window into four areas to enable you to 
view different areas of the same image at different magnifications. See 
later in this manual for more details. 

Tabs display on the upper edge of the workspace to enable fast file 
selection when many files are open. The file workspace cannot be 
hidden or moved, though other screen elements can be positioned as 
required around and in the workspace. 

3.6.1 Workspace Area Right-click Menu 

Load a file into the Workspace Area and place the cursor in the display 
area and click the right mouse button to reveal a menu of the options 
available for the workspace. 

3.7 Block List Bar 
The Block List Bar is one of the workspace panes available in the 
upper left corner of the workspace. If hidden you can click on the Block 
button to display it. Within a vector file, vector entities (lines, circles 
etc.) can be arranged into groups, called blocks, and the blocks can be 
named. This Workspace Pane provides information about the various 
blocks of entities and references included in the file.  

The tree structure in this Pane enables you to toggle each block 
individually. 

3.8 Properties List Bar 
The Properties List Bar is one of the workspace panes available to the 
left of the workspace. If hidden you can click on the Properties button 
to display it. When selecting a part in a 3D file like IFC the properties 
of this part is listed in this pane. 
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3.9 Folder Explorer 
The Folder Explorer workspace pane shows the folders accessible 
from your computer. If hidden you can click on the Folders button in 
the upper left corner of the workspace window to display it. Its layout 
and function are similar to that of the standard Windows Explorer. The 
files contained in folders located using the folder explorer are listed in 
the file explorer. The folder explorer can be resized, and turned on and 
off. 

 

3.10 File Explorer  

 If hidden you can click on the File Explorer button 

in the lower left corner of the workspace window to display it. 

File Explorer Shows the various files contained in the currently active 
folder. The types of files listed will depend on the setting in the Files of 
Type toolbar.  

The file explorer can list the files in a number of ways: 

Large icons. 

Small icons. 

A simple list. 

A list with file details. 

As thumbnail pictures. 

 

3.10.1 Configuring the Information Columns 

When the Details option is selected, the file explorer displays the files’ 
details in columns. You can decide which columns of information you 
wish to display. 

3.10.2 Moving Columns 

When the Details option is selected, the file detail columns can be 
moved as required. See later in this manual for details. 

3.10.3 Sorting File Details 

The files listed can be sorted by name, size, file type, modification date 
and attributes, in either direction (up or down). 
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Click on the appropriate column button to select the desired sort 
method. 

Click the same button again to toggle the direction (note the arrow 
indicating the sort direction). 

3.10.4 Opening Files 

Open files from the file explorer using standard Windows techniques: 

Drag and drop – Click on a file to highlight it, then drag it out from the 
explorer and release it in an empty area of the workspace. 

Double-click on a file to open it. 

To list only files of a particular type in the file explorer, click in the white 
part of the Files of Type list box or on the down arrow beside the box 
to open the pull-down selection list. Click on the desired file type to 
display only files of that type in the list. 

3.10.5 File Explorer Right-click Menu 

Place the cursor in the file explorer (but not on an actual file name) 
and click the right mouse button to display a pull-down menu of the 
options available for the explorer.  

 

If the cursor is located on a file name when the right mouse button is 
clicked, a standard Windows right-click pull-down menu will be 
displayed. 

3.11 Layer List Bar 
The Layer List Bar is one of the workspace panes available in the 
upper left corner of the Workspace. If hidden you can click on the 
Layers button to display it.  This Workspace Pane enables you to turn 
on and off selected layers in a multi-layer file. 

At the top of the pane some buttons will allow you to control the display 
of individual layers. Using standard Windows selection techniques, 
select the layers you wish to toggle. 

 

 Show Selected Layers – Click this button to turn selected layers 

on. 
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 Hide Selected Layers – Click this button to turn selected layers 

off. 

 Toggle – Click this option to toggle the selected layer to the other 

setting (on or off). 

 Restore Default Settings – Click this option to reset the layers to 

their default values (as they were when the file was initially opened). 

Note  When printing a file, only the displayed layers will be printed. 
The layer columns can be rearranged, resized and sorted. 

3.12 Page List Bar 
The Page List Bar is one of the workspace panes available in the 
upper left corner of the Workspace. If hidden you can click on the 
Pages button to display it.  If a document contains multiple pages or 
views you can display a thumbnail of each page/view in the Page List 
Bar. You can navigate in the multi page document or drawing by using 
the mouse to select individual pages/views. To speed up paging using 
the Page List Bar you can turn off the thumbnail image using the 

thumbnail image button.   

PDF Bookmarks can also be displayed in the pages List Bar. If the 

opened PDF contain Bookmarks this button  becomes enabled. 

Click on the button to display the PDF Bookmarks. 
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3.13 Markup Symbol Bar (RxHighlight) 
If hidden you can click on the Symbols button in the upper left corner 
of the workspace window to display it. The Markup Symbol Bar is used 
to insert markup symbols from a Rasterex Symbol library file.  

 

To insert a symbol from the list either double click the symbol or select 

the symbol and click on the Add Symbol To Drawing button.  The 

symbol will be added to the center of the workspace window. 

 

If you have access to multiple symbol libraries you can select the 

library you want by clicking the  Setup Symbol Library Location 

button. The following Dialog will appear. 

 

 

Figure 7 Symbol Libraries Setup dialog 

 

This dialog will allow you to either select an existing Symbol Library 
File or connect to an existing Symbol Library Server. 

 

Symbols are saved as other markups to a markup file associated with 
the viewed file. 
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3.14 Markup List Bar (RxHighlight) 
 

 If hidden you can click on the Markup List button in 

the lower left corner of the workspace window to display it. RxHighlight 
Markup List Bar contains a list of the comments associated with the 
currently open file. 

The list provides instant information about any particular comment 
entity.  

 

The comments listed can be sorted by User, Entity, Layer, Date, and 
Content. Content is any text that may appear in association with a 
comment entity.  

Columns can be turned on and off by right clicking on a column header 
and select the column that should be displayed from the drop down 
menu, 

3.14.1 Markup List Bar Right-click Menu 

Place the cursor in a Markup List Bar column and click the right mouse 
button to display a pull-down menu of the options available for the 
Markup List Bar.  

Locate – Right click on a comment entity line in the list and select 
Locate from the right click menu. RxHighlight will then zoom into that 
particular comment in the drawing. 

Revision history – Right click on a comment entity line in the list and 
select Revision history from the right click menu. This will bring up the 
Markup Revision history dialog that show the revision history of the 
comments in associated with the current drawing. This dialog has four 
buttons, locate, purge, restore and close. The locate button will work in 
the same way as the Show function described above. Restore will 
restore one or more deleted comments. Purge will permanently delete 
one or more comments. 
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Figure 8 Markup Revision History dialog 

Print Report – Right click on a comment entity line in the list and 
select Print Report from the right click menu. This will bring up the 
Print Report dialog that allows you to print a markup report. You can 
select to print the report with the drawing and comment list on a single 
page or on two separate pages. 

 

 

Figure 9 Markup Report dialog 
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3.15 Workspace Title Bar Buttons 
In the upper right corner of the Workspace window there are additional 
buttons that activate the following functions from left to right. 

 

Windows 

This button item opens the Windows dialog. This dialog lists the files 
that are currently open in the viewer, in the order in which they were 
last active, with the currently active file at the top of the list. 

This button also gives access to a drop down menu with functions that 
operate on open files. 

Close All – Close all open files. 

 Next – Activate next file. 

 Previous – Activate previous file. 

 Cascade – Cascade all open files. 

 Tile Horizontal – Tile all open files horizontally. 

 Tile Vertical – Tile all open files vertically. 

 Arrange Icons – Arrange the icons of minimized open files. 

Split - The active file’s window can be split into four areas to enable 
you to view different areas of the same image at different 
magnifications. Once you have split the window into four, you can 
move the vertical or horizontal dividers as required to resize the sub-
windows. If you move one of the dividers to the edge of the window, 
the divider will disappear, giving two sub-windows. Re-select the 
Window > Split menu item to return to four sub-windows. 

 

Full Screen Mode – Display the currently open file using the entire 
screen. 

 

Style – Allow you to select a color scheme for RxView/RxHighlight. 

 

Help – Display the RxView help file. 

 

About – Display the Application about dialog. 
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3.16 Quick Access Toolbar 
In the upper left corner of the Workspace window you will find the 
Quick Access Toolbar 

 

This toolbar gives quick access to the most used functions in RxView. 

You can customize this toolbar and add additional functions to it by 
selecting More Commands from the Quick Access drop down menu. 

 

See chapter Customize Dialog for more information. 
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Chapter 4 Viewing Features and Samples 

 

The samples demonstrate powerful features that are available using 
this application. The samples may vary depending on your installation. 

4.1 Samples folder 
The samples in this folder can be loaded by the application either 
singly or as a selection using the Open dialog. The samples 
demonstrate screen display and printing for a range of the file formats 
supported by Rasterex viewing applications. 

Samples include: 

Document formats including Word, text and Acrobat reader PDF. 

Spreadsheets including Excel 

Pictures and raster files including TIF, GIF, JPG, BMP 

Drawings including AutoCAD DWG, MicroStation DGN, other CAD 
formats and HPGL plot files.  

3D drawing files including SolidWorks, STL, IGES, ACIS/SAT, etc. 
Also Catia, Pro-E, I-DEAS and UniGraphics if the required licenses 
are installed. 

4.2 Compare folder 
The samples in this folder demonstrate a feature for comparing 
revisions of drawing files. Load the file with extension XWS to view the 
displayed differences between the two revisions. The differences are 
in the window marked (Overlay). To examine the compare dialog, click 
the dropdown button on the Open icon and select Overlay. The 
compare function is described in detail later in this manual. The 
Compare samples will only function with CAD and Full versions. 
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4.3 Overlay folder 
The samples in this folder demonstrate a feature for overlaying files to 
create a montage of drawing and picture files. Load the file with 
extension XWS to view an overlay of the loaded files. The overlay is in 
the window marked (Overlay). To examine the overlay dialog, click the 
dropdown button on the Open icon and select Overlay. The overlay 
function is described in detail later in this manual. 

The Overlay samples will only function with CAD and Full versions.  

4.4 Markup folder 
The samples in this folder are a project demonstrating markup 
features including links to other files, text items and drawing objects.  

  

Load the file TRACER.TGA.  

Click any link button  in the Markup toolbar to view an 
associated link file.  

Click the link button in the loaded file to return to your original file. 

 

Linking and Markup are described in detail later in this manual.  

The Markup samples will only function with CAD and Full versions. 
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Chapter 5 RxView button menu 

 RxView has a button menu that is accessible from the button in upper 

left corner. This button give access to a group of key functions in 
RxView. 

 

5.1.1  Open 

 Opens a standard File Open dialog. Browse, select and open any file.  

 

5.1.2  Recent Documents 

 The panel to the right will contain a list of  previously opened files. 
Click on the file name to open the file in RxView. 

 

5.1.3  Save As  

 This will open the Save As dialog where you can select from available 
target formats. 

 

5.1.4  Publish 

Select from various publishing formats in the panel to the right, 
currently you can choose from PDF, Rasterex publish format and 
Rasterex compressed publish format. 

 

Publish to Rasterex Content Format – Rasterex Content format is a 
proprietary format created by Rasterex that contain all the information 
from the original format that can be extracted by the viewer. 
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Figure 10 Publish to Rasterex Content format dialog 

The content format can be created with a password protection and 
restrictions can be set that limit what the user is allows do with it. 

 

Publish to Rasterex Content Package – Rasterex Content Package 
format is a proprietary compressed format created by Rasterex that 
contain all the information from the original format and optionally 
markup that can be extracted by the viewer. 
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Figure 11 Publish to Rasterex Content Package format dialog 

The content format can be created with a password protection and 
restrictions can be set that limit what the user is allows do with it. 

 

 

5.1.5 Print 

Opens a standard Print Setup dialog. 

This menu has four sub menus. 

 

Print – Same as clicking the print button directly. 

 

Printer Setup – Opens the printer setup dialog for printer 
configuration. 

 

Print Preview  - Changes the display to the Print Preview window, 
enabling you to see the image, as it will appear on paper before you 
print it out. 
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 Send File Directly to Printer - Printer file formats like HPGL can be 
sent directly to the printer as they are already in a printer format. Some 
printers also support raster formats like tiff directly. Use this function to 
bypass the printer driver and send the printer data directly to the 
printer. 

 

5.1.6  Tools 

Contain the following sub menus. 

 

 AutoCAD Recover - Some AutoCAD files that fail to open using the 
Open button can be opened using Recover. Recover Opens a 
standard File Open dialog. Browse, select and open the AutoCAD file. 

 AutoCAD Conversion – Use this to convert from one version of 
AutoCAD to another. 

Batch Printing - Opens the Batch Print dialog. Use this to print a 
number of files in a batch operation. 

 Batch Convert - Batch Convert button opens the Batch Conversion 
dialog that enables you to convert multiple files as a Batch job. 

 AutoCAD Batch Convert – AutoCAD specific Batch Convert function 
that enables you to convert from DWG and DXF files to other versions 
of DWG and DXF files as a Batch job. 

 

5.1.7 Send 

You can send a file with its associated markup to another user by e-
mail using the Send function. 

This function has two sub menu items. 

Send As PDF – Converts the active file to PDF create an e-mail with 
the PDF attached. 

Send As Raster – Converts the active file to a supported raster format 
and create an e-mail with the raster file attached. 

 

5.1.8 Close 

Close the active file. 
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Chapter 6 Ribbon Buttons  

Buttons may only be active for specific file types, e.g. Office 
documents, 3D drawing files, CAD files etc.  

Buttons often lead to extensive new dialogs and options. The dialogs 
are described in detail in the next chapter.  As you work with RxView 
use this chapter for a short explanation of toolbar and button 
functionality. Use the next chapter for an explanation of the file dialogs 
that appear. 

6.1 Home Ribbon 
The Home ribbon holds the buttons used to operate common functions 
within RxView. 

6.1.1 File Panel 

File Panel contain functions for handling files. 

 

Open 

Displays a file open dialog where you can select a file to open. 

 

Information 

Displays the active file properties. Size, file type etc. Press ESC to 
close the File Properties dialog. 

 

Open Previous  

 
This button will display once you have opened a file. Click to open the 

previous file, as listed in the currently selected folder. 

 

Open Next  

 
This button will display once you have opened a file. Click to open the 

next file, as listed in the currently selected folder. 
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Save As 

Opens a save as dialog allowing you to save the currently open file to 
another format. In addition this button has a submenu with the 
following items. 

 

Save as Vector 

Select from a number of Vector target formats that you want to save 
the currently active file to. Only vector formats can be saved to another 
vector format. 

Save as Raster - Select from a number of Raster target formats that 
you want to save the currently active file to. 

Publish to PDF - Publish the currently active file to PDF. 

Publish to RXC - Publish the currently active file to Rasterex RXC 
format. 

Publish to RXP - Publish the currently active file to Rasterex RXP 
format. 

 

Print 

 Opens a standard Print dialog. 

 

Print Preview  

 Changes the display to the Print Preview window, enabling you to see 
the image, as it will appear on paper before you print it out. 

Pen Table  

 
Click this button to open the Pen Table Settings dialog, enabling you to 

set line widths etc. for vector files. 

Print Area  

 
Use the mouse to select a specific area of the active document to 

print. 
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6.1.2 View Panel 

View panel contains functions for navigating and changing the display 
of the currently open file. 

 

 

 Zoom All - Zooms the image to fit either the display area width or 
height depending on which dimension is reached first. This button has 
3 drop down menu items. 

 Zoom Extents – Same as Zoom All. 

 Zoom Limits – Some AutoCAD files has a defined “Limit” use this 
option to zoom to the Limit instead of the Zoom Extents function. 

 Zoom All State - This function ties the image size to the window size.  

 

 

 Zoom Window - Zooms in to a particular area of the file and fits it to 
the view window. Click on the top-left of the area to be viewed and 
hold down the left mouse button. Drag to the selected area and 
release the button. 

 

Zoom 1:1  

 
Zooms the image to its actual size. If the image extends beyond the 

borders of the display area, pan slider buttons will appear as required. 

 

Zoom In  

 
Zooms in to the image in steps. Click the Zoom Out button to reverse 

the process. 
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Zoom Out  

 
Zooms away from the image. Click the Zoom In button to reverse the 

process. 

 

Zoom Width  

 
Zooms the image such that it fits across the width of the viewing area. 

If the image is then taller than the viewing area, the top edge of the 
image will be placed at the top of the viewing area and the vertical 
scroll bar will be displayed at the right side. Use the scroll bar to view 
the parts of the image that are outside the viewing area. 

If the height of the image is less than the height of the viewing area, 
the image will be centered vertically in the area. 

 

Zoom Height  

 
Zooms the image such that it fits vertically within the height of the 

viewing area. 

If the image is then wider than the viewing area, the left edge of the 
image will be placed at the left of the viewing area and the horizontal 
scroll bar will be displayed below. Use the scroll bar to view the parts 
of the image that are outside the viewing area. 

If the width of the image is less than the width of the viewing area, the 
image will be centered horizontally in the area. 

 

Zoom Previous  

 
Click this button to return to the previous zoom state. Retains 

information about the last 10 zoom states. 

 

Zoom In/Out  

 
Enables you to click the left and right mouse buttons to zoom into and 

away from the file respectively. Hold in the left mouse button and drag 
the mouse to zoom in and out dynamically. 
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Zoom slider 

 Zoom Slider function enables you to zoom the active file in or out by 

using a slider. 

 

 

Pan Hand  

 
Enables you to view parts of an image that are outside the window by 

grabbing the image and moving it. Hold in the left mouse button and 
drag the mouse to pan. 

 

Flip X 

 Allow you to mirror the drawing around the x-axis. 

 

Flip Y 

 Allow you to mirror the drawing around the y-axis. 

 

Rotate to 0 degrees 

 Set the rotation of the drawing to 0 degrees counter-clockwise. 

 

Rotate to 90 degrees 

 
Set the rotation of the drawing to 90 degrees counter-clockwise. 

 

Rotate to 180 degrees 

 
Set the rotation of the drawing to 180 degrees counter-clockwise. 

 

Rotate to 270 degrees 

 
Set the rotation of the drawing to 270 degrees counter-clockwise. 

 

Rotation Slider 

 
Use this to rotate drawing in 1 degree steps using a slider. 
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6.1.3 Pages and Layouts Panel 

The pages list pane can be activated by clicking on the small arrow in 
the bottom right corner.

 

 

 

Page List Box 

Indicates the current page/view being displayed, and allow available 
pages to be selected. 

 

Layout List Box 

Indicate the current layout being displayed, and allow available layouts 
to be selected. 

 

Page Down  

 
Page down through multi-page files. The button is grayed when the 

last page is reached. The button is grayed on single page files. 

 

Page Up  

 
Page up through multi-page files. The button is grayed when the first 

page is reached. The button is grayed on single page files. 

 

6.1.4 Tools Panel 

The Tools Panel contain various functions for image navigation and 
setup. 
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Measure  

Click the icon to initiate a measurement on the active file. The process 
measures the length of a line, the angle between 2 lines, or the area 
enclosed by multiple lines, inside the viewed file. Click with the left 
mouse button on 2 or more points that can include an area. Press 
ESC to terminate measurement and the Measurement Statistics dialog 
is presented. Use the Backspace key at any time to undo the last 
measurement point. 

 

Calibrate 

Click on the Calibration button to select The process measures the 
length of a line in the active file and enables the length to be converted 
to a measurement that will then apply to the scale in the active file.  
Click with the left mouse button on 2 points a known distance apart 
and the Calibration dialog is presented. 

 

Bird’s Eye  

Activates the Bird’s Eye View function. This function provides an 
overview of the file, and allows you to pan around and select areas to 
zoom. See later in this manual for further details. 

 

Magnifier  

 Activates the Magnifying Glass function, which magnifies a part of the 
active file and displays the enlarged area in front of the file. 

 

Magnifying Window  

 Activates the Magnifying Window function, which magnifies the part of 
the active file around the cursor. 
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6.1.5 Compare Overlay Panel 

 

Compare and Overlay 

 Activates the Compare and Overlay dialog. See later in this manual for 
further details. 

 

Select overlay 

 
Allow you to select an overlay and move/scale it using the mouse. 

 

Overlay properties 

 
Opens a dialog displaying the properties of the currently selected 

overlay. 

 

6.1.6 Edit Panel 

 

Find Text  

Displays the Find dialog that is used to search for text in a document 
or drawing. 

Find Next 

 
Search for the next occurrence of the search expression entered in the 

Find Text dialog. 

 

Extract Text 

 
Extract the entire text from the active document. 
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Edit 

 
Starts the editing application associated with the active file, and opens 

the active file in that application. 

 

 Select and Save 

 Select an area to save to file. 
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6.2 Markup Ribbon 
The markup ribbon contains the buttons for all markup related 
functions. 

 

6.2.1 Tools Panel 

 

Show Markup 

Toggles markups display. When markups are disabled, the remaining 
buttons in the markup toolbar are grayed out. 

 

Save 

 
Click this button to save your markups to file. The markups will be 

saved to a file with the same name as the markup file and with the 
extension as specified in the Markup Preferences dialog. The file will 
be saved in the directory specified in the Markup Preferences > File 
dialog. Default location for markups is the viewed file folder. 

 

Refresh 

 
Click on this button to save current markup and re-load the markup 

from file. Use this function if there are multiple users saving to different 
markup files using the 000-999 or X00-XZZ file types. 

 

Markup Report 

  This button will bring up the Print Report dialog that allows you to print 

a markup report. 
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Revision History 

 This button will bring up the Markup Revision history dialog that show 

the revision history of the comments in associated with the current 
drawing. 

Paste 

 This button will paste any graphical content on the clipboard as a 

markup entity in the active drawing or document. 

 

Import 

 Choose Import to import markup entities from existing markup files 

originally created for other drawings and documents. 

 

Export  

 Choose Export to export markup entities to other vector file formats. 

 Beside this button is drop down menu that has two items. 

- Export to Other formats, which open the same dialog as the Export 
button itself. 

- Export to Markup File, which allow you to save the markup to a 
specific XCM or RXM file  

RXM files are files where the markup entities are encoded using XML 
tag value pairs. 

 

Show next markup 

 
Locate and zoom into the next markup entity. Subsequent use of 

Show next markup will cycle through all existing markup entities and 
start on top with the first markup entity if the last markup entity is the 
current entity. 

 

Search  

 Displays the Find Markup Entity dialog. Use this dialog to Search for 

Markup entities by name or markup text matching a text search 
criteria. 
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Back and Forward 

 When navigating using markup hyperlinks you can use the Back and 
forward button to navigate files activated using markup hyperlinks. 

 

Layer Control 

 Click this button to open the Markup Layer Control dialog.
 

 
See chapter Markup Dialogs. 

User Control 

 
Click this button to open the Markup User Control dialog.

 

 
See chapter Markup Dialogs. 

 

Consolidation 

 Click this button to open the Consolidate Layers dialog. 

In addition you have access to a drop down menu from this button with 
the following options. 

 Layers – Open the Consolidate Layers dialog. 

 Pick Entities – Select this option to pick markup entities for 
consolidation using the mouse. 

 Options – Open the Consolidation options dialog. 

 
See chapter Consolidation. 

6.2.2 Edit Panel 

 

 

Line Width, Line Style and Hatch Style 

You can set the Markup line width and style from the drop down list 
boxes on this Panel. You can also set the hatch style for hatched 
markup entities. 
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Markup Layer 

Select the Markup Layer from the Markup Layer drop down list. 

Changing the Markup layer may not be available depending on the 
User configuration settings. 

 

Undo  

 
Undo the last markup made or edited. The button has only one undo 

level and is grayed out if there is no operation to undo. 

 

Properties 

 If you have selected a comment for editing you can click on this button 

to bring up the markup edit dialog for the selected comment. 

 

Move to front  

 
When two or more comments are overlapping you can move 

comments that are placed behind other comments to the front by 
clicking on this button. 

 

Push to back 

 
When two or more comments are overlapping you can move 

comments that are on top of other comments to the back by clicking 
on this button. 

 

Delete selected comment 

 
You can click on this button to delete the selected a comment. 

 

Edit  

 Click on this button to activate the Markup Edit function. This allows 

you to select a markup. Markup functions Edit, Move, Size, Rotate, 
Delete, Zoom, Cut and Copy are described in chapter Markup dialogs. 

The commands available for markups vary according to their 
properties. The cursor changes according to available functionality.  
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Select the  icon and click a markup, the user or commentator 

name and markup layer show in the status bar. 

 

Set markup color 

 Click on this button to select the markup color. To select markup color 

you need to have necessary user rights to choose comment color. 
With this button the user can set the color for the currently selected 
comment. 

 

Marker  

 
Click this button to toggle the drawing mode between Normal and 

Marker. In Normal mode you draw with opaque colors on the screen, 
while in Marker mode you draw with transparent colors. This gives the 
impression of drawing with a marker pen. Marker mode is effective 
when used on black and white documents such as text documents 
and mono raster images, but less useful on multi-colored images. 

 

6.2.3 Draw Panel 

 

 

PolyLines and Polygons 

 Lines and polygons are drawn using these buttons. 

Set the color and thickness of lines and arrows using the Line Width 
and Color settings in the Markup Preferences dialog. 

Toggle marker mode using the Marker button.  

Click one of the line buttons. Select from: 

  
Open - Connecting lines. 

  Closed - Closed lines whose enclosed area is transparent (unfilled). 
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 Filled - Closed lines whose enclosed area is opaque with the 

markup color (filled). 

 Edged - Closed lines whose enclosed area is opaque and 

assumes the background color  (filled). 

 
Hatched – Closed lines whose enclosed area is filled with the 

selected hatch pattern. 

 

To draw Lines.  Move the curser to the desired start point and click 
the left mouse button. Move the cursor to the desired end-point for the 
line then click the left mouse button again. If you now move the cursor 
further, another line will be drawn using the previous end-point as its 
origin. To stop drawing, click the right mouse button.

  
Orthogonal Mode Hold down the SHIFT key when drawing lines and 
the lines are snapped and drawn 45 or 90 degrees relative to the 
screen.   

  

Splines 

 Select this button to draw curved lines on the image. Curves have the 

same styles as lines. A curve requires 3 points.  

Click the Splines button 
 
and select the curve style from the list of 

buttons.  Select from: 

 
Open - Connecting curves. 

 
Closed - Closed curves whose enclosed area is transparent 

(unfilled). 

 Filled - Closed curves whose enclosed area is opaque with the 

markup color (filled). 

 Edged - Closed curves whose enclosed area is opaque and 

assumes the background color  (filled). 

 
Hatched - Closed curves whose enclosed area is filled with the 

selected hatch pattern. 
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To draw Curves.  Move the curser to the desired start point and click 
the left mouse button. Move the cursor to the next point and click. 
Continue to the end-point for the curve then click the left mouse button 
again.  Curves can be connected and each curve can be manipulated 
around its 3 points. To stop drawing, click the right mouse button. 

 

Rectangles / Rounded Rectangles 

 Select one of these buttons to draw a rectangular or rounded 

rectangular area. Note that rectangles can be restricted to squares. 

Click the appropriate button and select the style from the list of 
buttons.  Select from: 

 
Outlined - Rectangle whose enclosed area is transparent 

(unfilled). 

 Filled - Rectangle whose enclosed area is opaque with the 

markup color (filled). 

 Edged - Rectangle whose enclosed area is opaque and 

assumes the background color  (filled). 

 Hatched - Rectangle whose enclosed area is filled with the 

selected hatch pattern. 

 

To draw Rectangles, move the curser to the desired start point and 
click the left mouse button. Drag the cursor to draw a rectangle. Click 
the left mouse button again to terminate the action.  

Square Mode Hold down the SHIFT key when drawing rectangles or 
rounded rectangles and a square or rounded square is drawn.   

 

Ovals/Bubbles 

 Select one of these buttons to draw an oval or bubble. Note that ovals 

can be restricted to circles.  

Click the appropriate button and select the style from the list of 
buttons.  Select from: 

  
Outlined - Oval or bubble whose enclosed area is transparent 

(unfilled). 
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 Filled -  Oval or bubble whose enclosed area is opaque with 

the markup color (filled). 

 Edged -  Oval or bubble whose enclosed area is opaque and 

assumes the background color  (filled). 

 Hatched -  Oval or bubble whose enclosed area is filled with 

the selected hatch pattern. 

 

To draw Ovals or Bubbles, move the curser to the desired start point 
and click the left mouse button. Drag the cursor to draw an oval or 
rectangle. Click the left mouse button again to terminate the action.  

Circle Mode Hold down the SHIFT key when drawing circles or 
bubbles and a circle or symmetrical bubble is drawn. 

 

Arrows  

 Draws an arrow. Click the appropriate button and select the style from 

the list of buttons.  Select from:  

 
Single – an arrow. 

 Single filled - an arrow with a filled arrowhead. 

 Double - a double headed arrow. 

 Double filled -  a double-headed arrow with filled arrowheads. 

 

To draw Arrows, move the curser to the desired start point (head) 
and click the left mouse button. Move the cursor to the desired end-
point for the arrow then click the left mouse button again. 

 
Orthogonal Mode Hold down the SHIFT key when drawing arrows 
and the arrows are snapped and drawn 45 or 90 degrees relative to 
the screen.   

Snap. Enable Snap to snap and draw Arrows on drawings. 
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Eraser  

 
Click this button to draw markups that hide image information and

 
other markups. These markups are invisible but can be selected, 
moved and deleted like visible markups. 

Use this tool to draw free hand, as though with a pen, on the active 
image. Move the curser to the desired start point, click and hold the 
left mouse button, and move the cursor to draw. 

Set the thickness of the rubber using the Rubber Width setting in the 
Markup Preferences dialog. “Rubber” markup color always follows the 
background color of the file. 

 

 

Link  

 
You can add hyperlinks to most markup elements, and use these as 

link buttons. The special link markup element is a standalone link 
indicator. Click on this button to activate the Create Link function. The 
Link function is used to create links from the active image to other 
documents. 

A link icon is placed onto the active file so that the linked files can be 
opened by a left mouse button click.

 
Link information is stored in a Markup file. If the file registered in the 
link is not found in its original location, then the local folder from which 
the file and Markup is opened is searched.  

The Link function enables you to link other files to the active file. The 
function places a link icon onto the active file so that linked files can be 
opened.  

Making a Link. Activate the Link function by clicking the Link button in 
the RxHighlight toolbar. Place the cursor on the image where the Link 
icon is to appear. Click the left mouse button and the File Open dialog 
appears. Select the file to connect to the link button. A Link button 
appears at the selected spot in the view window.  

Opening a Link. To view an existing link, deselect the Redline Edit 
button on the RxHighlight toolbar, when the cursor is located over the 
link icon, click the Link icon on the image to load the file connected to 
the Link.
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  QR and bar code 

Click on these buttons to insert a markup bar code or QR image. 

 

Text  

 Click on this button to activate the Markup Text dialog. This is used to 

write text directly onto the active file, and is normally used for shorter 
markups. For longer text markups you are recommended to check the 
Hide the text in Note envelope option in the Markup Text dialog. A full 
description of the Markup Text dialog and functions is in chapter 
Markup Dialogs.  

Set the color in the Markup Preferences dialog. 

Set the text font size in the Font dialog displayed when you click on the 
drawing. When working with larger drawings you may need to 
experiment to find the appropriate settings.  

Set the color and thickness of the markup frame and arrow using the 
Line Width and Color settings in the Markup Preferences dialog. 

Note  If you cannot see the text you have written, or it is extremely 
small, this may be because the Line width and text size option is set to 
Absolute document units, i.e. relative to the size of the original 
drawing. For example, text written in a 10 pt. font on an A0 drawing will 
be virtually invisible. Click the Markup Settings button and set the Line 
width and text size to Current display units, then rewrite the markup. If 
you wish to delete the original markup, zoom in on the area till you can 
see the markup, then select and delete it in the normal fashion. 

Note  When the Line width and text size option is set to Current 
display units, the resulting markup text size will depend on the amount 
of zoom applied to the document when the text is written.  

To write Text, move the cursor to the desired start point, click the left 
mouse button where the text is to appear and the Markup Text dialog 
appears. 
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Figure 12 Markup Text dialog 

Write text markups into the dialog.  

To change the font, click the Browse button. The Font dialog appears 
enabling you to select the required font, text style and size. 

Check the Arrow and Frame options if required.  

Select the Frame type if used. 

Click OK to show the markup in the work area. 

Editing existing markups is described in chapter Markup dialogs. 

  

Note 

 The Text function is normally used for short comments. For larger 

comments, use the Note tool. Long markup texts can be stored in 
"Notes" so they do not cover the work area. To inspect the contents of 

a note, click on the note using the left mouse button. Editing text and 
notes is described in chapter Markup Dialogs. 
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Stamp 

 Use the stamp button to insert predefined and custom markup stamps. 

 The stamps dialog is described in chapter Markup Dialogs. 

  

Pen 

 Select this option to draw free-hand lines, as though using a pen, on 

the active image. Set the color and thickness of the pen using the Line 
Width and Color settings in the Markup Preferences dialog.  

To draw with the Pen, move the curser to the desired start point, 
click and hold the left mouse button, and move the cursor to draw the 
line. Release the mouse button to terminate.  

Save View 

 Select this option to save the current view to the markup file. Enter the 
name of the view in the Save Markup View dialog. 

 

Restore View 

 Select this option to restore a previously saved markup view from the 
markup file. Select the name of the view to restore from the Restore 
Markup View dialog. 

 

Checkmark 

 Inserts a checkmark as a markup entity in the current drawing. 

 Use the drop down menu next to this button to define the shape 
settings. 
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Figure 13  Default Shape Settings Dialog 

Size 

Set size in mm for the size of the inserted shape relative to the current 
drawing. 

 

Color 

Define the shape color or use the Default markup Color. 

   

 

6.2.4 Measure Panel 

 

 

Dimension Lines 

 Draws a dimension line with embedded measurement. Click the 

appropriate button and select the style from the list of buttons.  Select 
from:  

 

  
Horizontal Linear Dimension – a horizontal dimension line. 
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  Vertical Linear Dimension – a vertical dimension line. 

 Aligned Dimension -  a dimension line that can have an arbitrary 

orientation. 

To draw Dimension Lines.  Move the curser to the desired start point 
and click the left mouse button. Move the cursor to the desired end-
point for the arrow then click the left mouse button again. 

 
Orthogonal Mode Hold down the SHIFT key when drawing dimension 
lines and the lines are snapped and drawn 45 or 90 degrees relative to 
the screen.   

Snap. Enable Snap to snap and draw Dimension Lines on drawings. 

 

Measurement Area 

 Draws a measurement area with embedded area measurement and 

enclosed by lines. The area is always enclosed. Click the appropriate 
button and select the style from the list of buttons.  Select from: 

 

  
Outlined - Measurement whose enclosed area is transparent 

(unfilled). 

  Filled -  Measurement whose enclosed area is opaque with the 

markup color (filled). 

  Edged -  Measurement whose enclosed area is opaque and assumes 

the background color  (filled). 

  Hatched -  Measurement whose enclosed area is transparent and 

hatched. 

  Automatic Area measurement – If the drawing contain geometry that 

has an area like enclosed polygons you can automatically add a 
measurement object that cover the polygon by clicking on the polygon. 

  Area Measurement Summary – Opens the Area Measurement 

Summary dialog that is used to get a summary of all the measurement 
areas in a drawing. 
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To draw Measurement Areas, move the curser to the desired start 
point and click the left mouse button. Move the cursor to the next point 
and click the left mouse button again. Continue until you join up the 
lines at the start-point. To stop measuring, click the right mouse 
button.

  
Orthogonal Mode Hold down the SHIFT key when building the 
measurement area and the lines are snapped and drawn 45 or 90 
degrees relative to the screen.   

Snap. Enable Snap to snap and make area measurements on 
drawings. 

 

Counter 

 This tool is used to count objects in a drawing or document. Select the 

counter button and click on various elements in the drawing that you 
want to count. Get the total amount of counter markup entities when 
you click on the counter button again. 

 

Measurement Path 

 
This tool is used to measure a path consisting of line segments where 

you can specify a width and height to calculate volume. 
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6.3 2D CAD Ribbon 
The 2D CAD ribbon contains buttons that operate the 2D CAD related 
functions in RxView. 

6.3.1 Tools Panel 

 

Background – Select background color from the drop down menu. 

Inspector –  When active you can click on vectors and get information 
about the selected vector. 

Find Attributes – Click this button to search for a particular attribute. 
The button will be grayed out if there are no attributes. 

 

List Attributes for Selected Block 

 
Click this button to open a dialog with a list of attributes for the 

selected block. The button will be grayed out if there are no attributes.  

 Vector Anti-Aliasing 

 When on vector lines use Anti alias smoothing to enhance visibility of 
vector graphics. 

 

 

6.3.2 Blocks Panel 

 

 

Toggle Block Mode 

 
This button toggles the Block Utilities mode on and off. 
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Previous Block and Next Block 

 Click this button to move to the next or previous block in the file. The 

button is grayed out until the next or previous block button has been 
clicked or if there are no next or previous blocks in the list. 

 

Next Block with Attributes 

 Click this button to move to the next block in the file that contain 

attributes. The button is only available in block mode. 

 

List Attributes for Selected Block 

 
Click this button to open a dialog with a list of attributes for the 

selected block. The button will be grayed out if there are no attributes. 

 

Search Attributes 

 
Click this button to search for a particular attribute. The button will be 

grayed out if there are no attributes. 

 

 

 

 

 

6.4 3D CAD Ribbon 
The 3D CAD ribbon contain a group of functions that apply to 3D 
models. 

6.4.1 Tools Panel 

 

Reopen As 3D – Click this button to open AutoCAD files in 3D mode. 
This requires that the AutoCAD file contain 3D data. 
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Background – Set the background color for 3D models. 

Find Attributes – Click this button to search for a particular attribute. 
The button will be grayed out if there are no attributes. 

 

6.4.2 3D Mode Panel 

 

Orbit 

Toggles rotate state to turn the image to a specific view. Hold down, 
Ctrl, Alt or Shift keys when rotating to lock the X, Y or Z-axes. 

 

Walk 

Enables you to navigate through a 3D model from the first person 
perspective. 

 

Spin  

 
Enables you to set the image spinning. Hold down, Ctrl, Alt or Shift 
keys when spinning to lock onto the X, Y or Z-axes. 

6.4.3 3D Control Panel 

 

 

Smooth Rendering 

Default mode that display the 3D model with solid surfaces. 

 

Wireframe  

 
Removes the “fill” from the image, leaving just the framework. 
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Transparent 

Display 3D model as transparent. 

 

Explode 

Use this function with the Explode factor slider to move all parts in a 
3D model a certain distance from the center so that the various parts 
become separated. 

 

Sectioning Dialog 

 This opens a Section Clipping dialog with sliders enabling you to set 
up to six clipping planes. Each plane can be rotated around three 
axes, and may be inverted. 

 

Two Point Sectioning  

 This option enables you to cut the object using a single straight line, as 
if with a knife. You can then use the rotation and invert functions to 
move the object to achieve the desired view. 

 

 

 

 Toggle this button to activate and deactivate the sectioning function. 

You can set up the cutting planes while keeping the entire image, then 
toggle this button to view the image with and without the parts that you 
wish to cut away. 

 

Show Cross-Section Plane  

 Toggle this button to show and hide the cutting planes used by the 

sectioning function. 

 

Invert Cross-Section  

 This function inverts the visible cross section, showing the parts you 

have cut away and hiding the parts. 
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Perspective  

 
Toggles the image between isometric and perspective.  

 

Material and light  

 This open a material and light dialog where you can change the color 

and reflection properties of the rendered model. 

 

Reset Model  

 
Resets the image to its load state, as it looked when first opened. 

 

6.4.4 Parts and Blocks 

 

Restore Blocks 

Use this to reset the state of all blocks changed using Set Hidden or 
Set Transparent functions. 

 

Show Information 

Select a 3D block and the information for this block will be displayed in 
the properties pane to the left of the Workspace. 

 

6.5 BIM Ribbon 
The BIM Ribbon contains all functions relative to the manipulation of 
3D models with BIM specific information. Most of the functions can 
also be found on the 3D CAD Ribbon. 
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6.5.1 IFC Display State 

 

IFC element check boxes 

Select or deselect the various IFC element types to display or hide 
these elements based on type.  

 

Hide All - Hide all IFC Types. 

Show All - Show all IFC Types. 

 

Storey Slider 

Allows for separation of the different stories in an IFC model to display 
these separately. 

 

6.6 Tools Ribbon 
The Tools Ribbon contains all buttons for configuring the application, 
markup and format filters as well as batch functions. 

 

6.6.1 Batch Panel 

 

 

Batch print 

See Chapter 10.2 for more information on how to use Batch Print. 

Batch Convert 

See Chapter 10.3 for more information on how to use Batch 
Conversion. 
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AutoCAD Batch Conversion 

See Chapter 10.4 for more information on how to use AutoCAD Batch 
Conversion. 

 

6.6.2 File Panel 

 

 

Recent Files List Box 

The Address box contains the paths of files recently opened in 
RxView, and your current location in the file explorer. As you move 
through the archives using the file explorer, the path given in the 
address box will be updated. The toolbar holds two buttons: 

  Delete Item - Deletes the selected item from the pull-down list. 

 
Delete All Items - Deletes all the items in the pull-down list. Note  

Only the references are deleted from the list, the files are not deleted 
from their archive folders. 

 

Open Previous  

 
This button will display once you have opened a file. Click to open the 

previous file, as listed in the currently selected folder. 

 

Open Next  

 
This button will display once you have opened a file. Click to open the 

next file, as listed in the currently selected folder. 

Close  

 
Close the active file. 

 

Back Link and Forward Link  

 Move to the previous or next file in the link list. 
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One Page View  

 
Displays the current page only. 

 

Thumbnail View  

 
Displays thumbnail images of all the pages in the file window. 

 

Page and Thumbnails View  

 
Displays a combination of thumbnail images and the current page in 

the file window. 

 

Gridlines  

 
Toggles spreadsheet gridlines for displays and printing. 

 

Toggle Color  

 Toggles the background color of the active file through the four 
available options. White, Black, Gray and Custom. 

Choose your own custom color in the Tools > Options dialog.  

Note  Only the background of the active file is changed. 

 

 

 

6.6.3 Conversion Panel 

 

Save as Raster 

Select from a number of Raster target formats that you want to save 
the currently active file to. 

Save as Vector 
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Select from a number of Vector target formats that you want to save 
the currently active file to. Only vector formats can be saved to another 
vector format. 

 

 

6.6.4 Clipboard Panel 

You can select part of an image and copy it to the Windows clipboard. 
From the clipboard you can then paste the image part into another 
application. 

 

 

 

The format of the active document or drawing will determine what type 
of clipboard item that can be selected. 

 

Select between: 

Bitmap - The clipboard item will be a bitmap. 

Metafile - The clipboard item will be a metafile. 

Text - The clipboard item will be text. 

6.6.5 Settings Panel 

 

 

Filter Settings 

Opens the Filter Settings dialog. This dialog enables you to inspect 
and change settings for individual filters. 

 

Options 
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Opens the RxView Options dialog.  

The Options button also provide two drop down menu options. 

Reset License – Will reset the license information stored in the 
registry, allowing the license information to be set again or changed. 
This option requires that the user has administrator rights. The 
installation come with a built in Administrator user with user name 
“Admin” and password “admin”. 

Reset User Interface – Will reset the user interface to the installation 
defaults. 

 

Markup 

Click this button to open the Markup Preferences dialog. This dialog 
box has three tabs; General, File and Advanced.  

The Markup button also provide two drop down menu options. 

Layer Control – Opens the Markup Layer Control dialog.
 

 
User Control – Opens the Markup User Control dialog.
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Chapter 7 Configuration and Customization 

Options button on the Settings ribbon offers customization options for 
many smart features. This chapter describes the available dialogs and 
how to personalize your settings by creating your own toolbars, short-
cut keys, etc. 

RxView has extensive configuration settings including snap options, 
measurements, file filters, pen tables, and plugin management.  

7.1 Setting Up the RxView Options 
Click on the Options button Settings->Settings->Options  or click 
Options in the active file right-click menu to open the Options dialog 
shown below. 

7.1.1 General Tab 

 

Figure 14  Options dialog General tab 

 



 

 

75 

Configuration file path – The configuration file contain information 
about users rights and other user configuration data. This option is 
used to set the path to the Configuration file. 

Magnification factor – Is the zoom factor used for the magnifying 
glass and magnifying window function. See later details. 

Address history size – The maximum number of recently opened 
files displayed in the Address list box. 

Window menu contains – The maximum number of files to be listed 
in the Window > Windows menu list.  

Recent file list contains – Is the number of recently opened files 
listed in the File menu. 

Custom color picker – Enables you to select or create your own 
background color to be used in the Toggle Background Color list. 

Write settings to DEFAULT user registry key – Use this option to 
store RxView settings to a common user registry area to allow all 
users on the same machine to use the same settings. (Require) 
Administrator privileges. 

7.1.2 QuickView Tab (XP only) 

QuickView files are created for each original file when selected in the 
explorer. Use the QuickViews and/or thumbnail images to identify the 
file before opening. QuickView files may be saved using one of several 
methods. Use the options on this tab to set the save preferences for 
the QuickView files. These settings will apply for all files opened after 
the settings are made. 

Use embedded preview if available – Some file types may have a 
thumbnail view embedded in the file. 

Database storage 

 None – QuickViews are not stored but regenerated each 
time the file is accessed. This method can lead to delays 
while the QuickViews are created. 

 Single database file – As the QV files are created, they are 
stored in a specified folder as a database file. The QV files 
are then available for immediate use the next time you 
access the originals so delays are avoided. Set the required 
folder in the Local or Common folder options. 
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 Individual QuickView files – Each QV database file is stored 
in the same folder as the original file. The QV files are 
available for immediate use the next time you access the 
originals  

 

Figure 15  Options dialog QuickView tab 

Common folder – All the QV files created will be stored in a common 
folder. Check the option, and type in the path or use the browse 
function to specify the folder. This option will be grayed out if it is not 
applicable. 

Background Color. Select the background color to use for the 
QuickView. 

High Resolution Quickviews. Select this option if you want 
QuickView with high resolution. High resolution is 280x220 pixels. 
Standard is 140x120. 

Show QuickViews in File Open dialog. If you turn this on, a 
QuickView of the currently selected file will be displayed in the file 
open dialog. 
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7.1.3 Advanced Tab 

Check the applicable boxes to activate the function: uncheck the 
boxes to deactivate. 

 

Figure 16  Options dialog Advanced tab 



 

 

78 

Display Operations 

CAD style zoom window – Allows the zoom feature to operate in the 
same way as the corresponding feature in the AutoCAD program. 

Enable Wheel button Zoom and Pan – Check this option to enable 
the use of the mouse wheel for zoom and pan. 

Page layout mode – Check this option to display the drawing and 
document extent as a page. 

Show image extents – Check this option to display the boundaries of 
the displayed image. 

Fill drawing polygons – Displays vector polygons filled. Do not use 
this option if you require a faster display. 

Enable Fast Draw – Alternative display function that reduce the draw 
refresh speed but with a slightly reduced quality. 

Raster Display Options 

Scaled Raster Operations (to display an image perfectly will require a 

lot of processing, so displaying is a compromise between the accuracy 

of the display and the time taken to calculate the image.) 

Normal – Raster scaling is the fastest method of displaying during 
zooming. Some black areas may disappear during zooming. 

Scale to gray – Scaling is the slowest method of displaying during 
zooming, but it gives the best display results. If you have problems 
reading, for example TIF files, use this option to improve clarity. 

Preserve black – Scaling is the next fastest display method. Some 
black areas may disappear during zooming. 

Use Halftoning for color images to display color images sharply 
regardless of zoom factor. 

Document Options 

Default Zoom Select the default scaling to use when paging a multi-

page document. 

Zoom 100% – Check this option if you wish to display the present 
page in the default Window’s document scaling (1440 twips). 
Depending on the size of your screen this option may create scroll 
bars in the document window.  

Retain page view – Check this option if you wish to keep the current 
zoom setting as you move to a different page in the document file. 
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Zoom all – Check this option if you wish to zoom the current page to 
the maximum possible within the window as you move to a different 
page in the document file. 

Zoom width - Check this option if you wish to zoom the current page 
to the width of the window as you move to a different page in the 
document file. 

Default Display Mode Select the default display mode to use when 

opening a multi-page document. 

Page View - Document is displayed as a single page only.  

Thumbnail View - Document is displayed as a set of thumbnails. One 
thumbnail for each page in the document.  

Page and Thumbnails View - Document is displayed as a single 
page in combination with a set of thumbnails for each page in a 
separate window. 

Thumbnail Options 

Thumbnail color – Set the background color for multipage 
thumbnails. 

Enable Table of Contents – Allow the display of bookmark list for 

PDF Files in the pages pane. 

CAD Options 

Show warning for missing XRef files – AutoCAD and MicroStation 
use XRefs. 

Show warning for missing font files – AutoCAD and MicroStation 
use font files.  
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Measurement / Calibrate Options 

Enable ortho – Restricts the measurement and calibration functions 
to orthogonal (vertical or horizontal) movement only. This function may 
be toggled using the F8 key. See later in the manual for further details. 

Display measurement dialog box – Allows the Measurement 
Statistics dialog box to display when you press ESC key after using the 
left mouse button to perform a measurement. See later in the manual 
for further details. 

Activate automatic pan during measurement – Will cause the 
drawing to automatically pan when a measurement operation is near 
the edge of the section currently displayed in the window.   

Snap Options 

Enable Snap – Switches on the Snap function for measuring. The 
cursor snaps to defined points on a line as it moves within range. This 
function may be toggled using the F9 key. See later in the manual for 
further details. 

Nearest – Snaps to the nearest line. 

End Point – Snaps to the nearest end-point on the nearest line. 

Middle Point – Snaps to the mid-point of the nearest line. 

Center – Snaps to the center of a circle or arc. 

Intersection – Snaps to line intersections. 

Snap tolerance (pixels) – Set the distance from the cursor in pixels, 
where the snap function will look for snap points.  

Snapbox Color – Set the color of the snap box for better contrast 
depending of the color of the drawing. 

Invert Drawing scale – Reverses the scaling so the same scale that 
is written a title block for a drawing in paper space can be used as 
written. 

Ask for a drawing scale – Displays a dialog that allow you to enter a 
scale for the currently opened layout when a measurement operation 
is initiated. 

Reset drawing scale to 1:1 – Resets the drawing scale to 1:1 when 
switching back to model space. 

3D Options 
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Show axis for 3D documents – Check this option to display the 3D 
axis in the lower left corner of the window for 3D images. 

Remove hidden lines – Check this option to remove lines (e.g. In 
Wire-frame view) that would normally be hidden by other surfaces. 

Gradient Background – Use a gradient color background when 
viewing 3D models. 

Magnifying Glass Shape 

Rectangular – Gives a rectangular magnifying glass frame. See later 
in the manual for further details. 

Circular – Gives a circular magnifying glass frame. See later in the 
manual for further details. 

Default Zoom Function 

None – No zoom function is active when the application is started. 

Zoom Window – Zoom Window function is active when the 
application is started. 

Pan – Pan function is active when the application is started. 

Zoom In/Out – Zoom In/Out function is active when the application is 
started. 

Printer Settings 

Remember last used printer – Check this option to make RxView 
remember the printer settings between sessions. 

Print hybrid files as bitmap – Some files are not reproduced 
correctly on paper if rotated. Turn this option on if text becomes 
inverted. 

Overlay and Compare 

Enable use of raster image when printing overlay and compare – 
Enable for printer drivers that does not support XOR color blending. 

Select resolution for raster image – Set resolution of printed raster 
for overlay and compare. 

Raster Image Print Options  

Enable transparent raster images – Option that can be turned off for 
printer devices that does not support transparent images. 

Invert monochrome raster images – Allow for drawings that uses 
white on black to be inverted before printing. 
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Scaled Raster Operations 

Normal – Raster scaling is the fastest method of displaying during 
zooming. Some black areas may disappear during zooming. 

Scale to gray – Scaling is the slowest method of displaying during 
zooming, but it gives the best display results. If you have problems 
reading, for example TIF files, use this option to improve clarity. 

Preserve black – Scaling is the next fastest display method. Some 
black areas may disappear during zooming. 

 

 Conversion 

Force use of device independent images when converting to 1 bit 

raster – Use to make sure dithering is not used when converting to 
monochrome raster images. 

Publishing settings 

Folder to use for published files 

Remember last used publishing folder – Save to folder last used 
when publishing a file. 

Always use same folder as viewed file – Save to folder where the 
file was opened. 

Open Published PDF files in default viewer – Opens PDF files in 
the application set up as default editor for the file type under filter 
settings. 
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Application Settings 

Dynamic network licensing – Enables the automatic switch to a 
RxHighlight license when a markup feature is being activated and 
allow all instances to take an RxView license on startup. 

SDI behavior – (Single Document Interface) Check this option if you 
wish to restrict RxView to having only one document open at a time. 
RxView will then automatically close the open document if another is 
opened. 

Don’t save active folder – Makes sure that the last used folder is not 
remembered when a file is opened from or saved to specifically 
selected folder. 

Show Windows Tabs – Tabs for each open file is displayed to allow 
fast selection of open files. 

Use local copy of opened file - RxView makes a copy of the active 
file so that the file is not locked for other users. The copy is deleted 
automatically when the file is closed.  

Keep RxView always on top – keeps RxView always in the front on 
your display. 

Show ZIP Archive dialog – Display the ZIP Archive dialog when 
opening zip files, allowing the user to select which files in the archive 
to open. 

Allow only one running instance of RxView – If checked you can 
only run one instance of RxView on the same computer. 

Enable maximize, minimize and restore buttons for MDI windows 
– When on the MDI windows can be minimized, maximized and 
restored. (Require that MDI Tab Groups are turned off) 

MDI Tab Groups – When on the window functions cascade and tile is 
unavailable. 

Enable application idle timeout. – Will cause RxView to 
automatically terminate if the application is left idle for a given time 
period. 

Allowed idle time before application terminates – Will determine 
how long RxView will run in an idle state before terminating, if Enable 
application idle timeout is turned on. Set the time in hours.  
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Click Apply to apply changes and keep the dialog open, click OK to 
apply the changes and close the dialog, and click Cancel to cancel any 
changes and close the dialog. 
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7.1.4 File Types Tab 

To speed up searches and loading, instruct RxView to ignore specified 
file types by adding file type extensions to the list. 

 

Figure 17  Options dialog File Types tab 

To add a file type to the list, type the appropriate file extension into the 
Add to list box and click Add. 

To remove a file type from the list, select the file type in the list and 
click Remove. 

Click Apply to apply changes and keep the dialog open, click OK to 
apply the changes and close the dialog, and click Cancel to cancel any 
changes and close the dialog. 

You can add a custom search filter that is used in the file open dialog. 

Enter a title for the filter and add extensions that should be included in 
the search filter separated by a semi colon. Ex *.ext;*.fil 
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7.2 Customize Dialog 
Right click on a ribbon or select Customize Quick Access Toolbar from 
the Quick Access drop down menu to open the Customize dialog 
shown below. 

7.2.1 Quick Access Toolbar 

In this dialog you can add functions to the quick access toolbar, and 
set Keyboard shortcuts for any ribbon button. 

 

Figure 18  Customize dialog > Toolbars tab 

 

 



 

 

87 

Keyboard 

In the Customize Keyboard dialog you can select and change the 
RxView accelerator keys. An accelerator key can be allocated to any 
function included in a menu for example, CTRL + O is the Windows 
shortcut key to initiate the File Open function. Accelerator keys are 
used to speed up access to commonly used functions. To allocate or 
edit an accelerator key, proceed as follows: 

  

1. Open the Customize Keyboard dialog by selecting the Keyboard 
shortcuts Customize button. 

 

Figure 19  Customize Keyboard dialog 

2. Select Category, and then choose the command you whish to set 
an accelerator key for from the Commands list. 

3. The accelerator key if any is displayed in the Current Keys field. 

4. Delete existing shortcut keys as required by selecting them in the 
Current Keys field and click Remove or Reset All. 

5. Set the cursor in the Press New Shortcut Key: field, then enter the 
keyboard keys that you wish to use to activate the selected 
function. 

6. Click Assign to copy the shortcut key sequence to the Current 
Keys: field. 
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7. The new accelerator keys are immediately applied when you 
close the dialog. 

 

Examples 

For document and multipage raster files: 

 Ctrl-Home go to first page 

 Ctrl-End  go to last page 

 Ctrl-PgDown  go to next page 

 Ctrl-PgUp go to previous page 

 

7.2.2 Minimize the Ribbon 

Right click on a ribbon and select Minimize the Ribbon from the 
context menu. 
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Chapter 8 RxView Dialogs  

8.1 Filter Settings 
The Filter Settings dialog holds information about the various file filters 
and their setup options. Click the Filters button on the Settings Ribbon. 

8.1.1 General Tab 

When you open the Filter Settings dialog, you are presented first with 
a list of the filters and the General tab. Pan to and select the filter to 
set up. The General tab shows types of files the selected filter 
supports, the file group (text, vector, raster etc.), the version and name 
of the filter, and whether the filter is currently licensed.  

 

Figure 20  Filter Settings dialog, General tab 

 

Priority – Give the filter a priority. Filters with a higher priority will be 
interrogated first when RxView is attempting to recognize an 
unidentified file type. Use this option to prioritize a filter. 
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Wildcard – On installation, the various filters are installed with a 
wildcard matching the normal file extension, but you may add or use 
other extensions. Write optional wildcards in this field for selected 
filters. The File Open dialog box then uses these wildcards to search 
for matching file types in the selected folder. Multiple file extensions for 
a filter can be used. Each wildcard must be separated by a semicolon, 
for example, *.TXT;*.ASC;*.DAT. 

Disable this filter – Check this box if you know you will not need to 
use a particular filter. This will prevent the filter being used. The box 
will remain checked until you uncheck it. 

Associate files of this type with RxView – Check this box to 
associate files that use the selected filter with RxView. Thereafter, 
when you double-click on a file with the same extension, RxView will 
open and the file will be loaded.  

Note  This function does not work in the trial version of RxView R12. 
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8.1.2 Measure Tab 

This tab is used to set up the scale of the image and calibrate it to 
enable measurements to be made on the screen. 

 

Figure 21 Filter Settings dialog, Measure tab 

Type – Set the type of units required for files associated with this filter. 
Choose between System, Imperial, Metric and User. 

 System – No units of measurement are specified for this 
filter, so RxView will use the default units specified by the file. 

 Imperial – Use imperial units for the filter. 

 Metric – Use metric units. 

 Custom – Define your own units for the filter. Name the units 

Measure Unit – Set the measure units that are used for measurement 
and file dimensions. 

Decimal Precision – Must be input for the selected units. The 
decimals are shown in the X and Y coordinate fields located in the 
right end of the status bar when a drawing is loaded. 
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Resolution – Some files have a resolution in dots per inch included in 
the file. 

Select the appropriate scaling that is representative for the files 
you are operating on. The scaling is a ratio between the 
measurement system selected and the document internal 
coordinate system. 

Depending on the type of units selected, the resolution will be 
shown in dots per inch, dots per mm or the user-defined unit 
selected for the filter. 

Many CAD formats do not have absolute units of measurement, 
so the UPI from file is not relevant. For these files you must 
decide the length a unit is to have measured in the selected 
measurement system. 

Calibrate allows you to set the scale of a drawing. Refer to paragraph 
Calibrating an Image for further details. 

When available use UPI from file – Some file types contain UPI 
(Units per Inch) information. Check this box if you want to use UPI 
information in your measurements. 

Custom unit name – If you wish to define your own unit of 
measurement, give it a name here. 
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8.1.3 Advanced Tab 

This tab is used to set additional settings for the selected file format. 

The options available will vary depending on the file format. 

 

Figure 22 Filter Settings dialog, Advanced tab 

Display Settings 

Background color – Sets the default background color to be used for 
files supported by the selected filter. See Setting the Background Color 
later in this chapter. 

Keep drawing colors – Normally, if a color on the image is very close 
to the background color (for example a light gray line on a white 
background), RxView will invert the color to obtain a better contrast 
and make the object more visible. If you check this box, RxView will 
keep the original colors but you may then risk losing details from the 
image. 

Mono Drawing – Will display vector files, e.g. DWG, DGN, in 
monochrome rather than color. 
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Mono Drawing Color – Use this to set the color used as 
monochrome drawing color. 

Pen Table - Select a pen table file (.RPT) if one is available. You can 

create pen table files via the Pen Table Settings button  in the Print 

Panel on the File Ribbon. See Pen Table Dialog later in this chapter 

for further details. This option is only available for format that supports 

pen tables. 

Auto load pen table settings – When the box is checked and a pen 
table file is selected, that pen table file will be used automatically when 
a file using the selected filter is opened. 

Pen Table Path – Choose the Pen Table File (*.RPT file) to use with 
the Auto load pen table setting. 

Other Settings 

Load Rotation – If a large percentage of the files supported by this 
filter need to be rotated before opening (for example they may have 
been scanned at a different angle), you can preset a rotation angle 
here. See Rotating Images later in this manual. 

Open with embedded viewer – By checking this option you can tell 
RxView to open and use a viewer embedded in the file instead of 
using RxView. Then when you open a file of the selected format, the 
embedded viewer will open as a window in the RxView workspace, 
with the file opened within that viewer. 

Note  This may improve viewing capabilities for some file formats, but 

the markup function will not work within “external” viewers. 

Edit Application – RxView is a viewing application. If you wish to edit 
the actual image file, you will need to start an editing application 
suitable for that image type. Use this field and/or the browse button to 
register the application for the image type. 

 

8.1.4 Advanced Tab, AutoCAD 

The filters included with RxView enable you to see the various files in 
the workspace. You can configure each filter separately, such that the 
files associated with each filter are presented in a way suited to your 
requirements. Apply to CAD and Full versions only 
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Figure 23 Advanced Tab,  AutoCAD 

This tab enables you to set display and font options for files created 
using AutoCAD. The options are as follows: 

Display Line Weights – Check this box if you wish to display 
AutoCAD line weights that are defined in the drawing. 

Scale Line Weights – Check this box if you wish to display AutoCAD 
line weights scaled using current zoom factor. 

Open Using Last Displayed View – Check this box if you wish to 
display the drawing zoomed to the last saved view. 

Apply Pen Table to Text Elements – Turn off to make sure text 
elements are not affected by changes to the pen table. 

Load ACIS 3D Models – Check this box if you wish to allow the filter 
to load 3D ACIS models. Note that these models may take a 
considerable time to load. 

Load Blocks and Attributes – Check this box if you wish to search 
for and list block attributes. 
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Use Default Layer Settings– Check this box if you wish to Use 
ensure correct display of content according to layer state. This option 
will however disable the ability to turn layers on/off. 

Recalculate Extents – Check this box to use make sure that you can 
zoom to extent even if you use the Open Using Last Displayed View 
option.  

Load Named views – Check this box to allow you to select  Named 
views.  

Use AutoCAD Fonts – Check this box if you wish to allow the filter to 
use AutoCAD fonts. 

Font Folder – If you wish RxView to use AutoCAD fonts, input the 
path to the folder containing the font files. 

Default Font – Input the name of the font file you wish to use as 
default. Check the Use Default Font box if you wish to restrict RxView 
to using that particular font. 

External reference files – Type in folders where the filter is to search 
for externally referenced drawings. You may specify several folders 
separated by “ ; “ e.g. C:\XREFS; C:\AUTOCAD etc. 
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8.1.5 Advanced Tab, Binary 

 

Figure 24 Advanced Tab, Binary  

This tab enables you to set the default font and the default paper size 
for each page for a binary file. 
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8.1.6 Advanced Tab, CalComp 

Apply to CAD and Full versions only 

 

Figure 25 Advanced Tab, CalComp 

A file may be set up to print correctly on a specified CalComp plotter. 
The Rasterex filter must then be configured to interpret the file settings 
such that the file can be printed to a different unit. This tab enables 
you to configure the settings. 

Autodetect Settings – Check this box if you want the filter to search 
for the required settings automatically. 

Use Checksum – Check this box if a checksum is used. 

Sync Value – Set the number of synchronization characters to be 
used. 

End Of Block Character – Input the appropriate end-of-block 
character. 

Use Extra Sync – Check this box if an additional sync. value is to be 
used. 
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Extra Sync Value – Set the number of extra synchronization 
characters to be used. 

8.1.7 Advanced Tab, MicroStation 

Apply to CAD and Full versions only. 

 

Figure 26 Advanced Tab, MicroStation  

This tab enables you to set the path to the required font resource file 
and reference file folders for MicroStation files. Apply to CAD and Full 
versions only. 

Always use 2D Display List – Check to force a drawing to be 
displayed as a 2D image even though it may originally be a 3D 
drawing. 

Add .DGN Extension to Reference Files – Add the DGN file 
extension to reference files to simplify file searches. 

Load Raster Reference Files – You can deselect this option to 
reduce the time taken to load a hybrid file. 

Use Fonts – Check this box to instruct the filter to use a Microstation 
font resource file. 
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Font Resource File  – If you check the above box, type in the path of 
the required font file or browse to it. 

External Reference Files – A DGN file can include references to 
other files. Type in the path to the appropriate folder or browse to the 
file. Up to 4 file paths can be entered.  

8.1.8 Advanced Tab, MicroStation V8 

 

Figure 27 Advanced Tab, MicroStation  

This tab enables you to set the path to the required font resource file 
and reference file folders for MicroStation files. Apply to CAD and Full 
versions only. 

Display Line Weights – Check this box if you wish to display 
Microstation line weights that are defined in the drawing. 

Recalculate Extents – Check this box to use make sure that you can 
zoom to extent even if you use the Open Using Last Displayed View 
option. 

Font Resource File – Type in the path of the required font file or 
browse to it. 



 

 

101 

External Reference Files – A DGN file can include references to 
other files. Type in the path to the appropriate folder or browse to the 
file. Up to 5 file paths can be entered. 

8.1.9 Advanced Tab, Gerber 

 

Figure 28 Advanced Tab, Gerber 

This tab enables you to set the default units and the aperture number, 
shape and size for Gerber files. 

File Units – Select the type of units to be used for the file. 

Incremental Coordinates – Check this box if the file uses incremental 
coordinates, otherwise absolute coordinates will be used. 

Aperture Number – The number of the aperture you wish to 
show/change. 

Shape – The shape of the aperture. 

Width – The size of the aperture along the X-axis, given in the file 
units selected. 

Height – The size of the aperture along the Y-axis, given in the file 
units selected. 
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Hole Size - If an object contains a hole, for example a do-nut, this 
defines the size of the hole. 

Note  Some of the parameters depend on the shape selected. 

Next – Show the next aperture. 

Prev – Show the previous aperture. 

Goto – Opens an “aperture selection” dialog where you can enter the 
aperture you wish to show/change. 

Aperture Units - Unit specified for a particular aperture. 

8.1.10 Advanced Tab, PDF 

 

Figure 29 Advanced Tab, Acrobat PDF 

Render PDF as image – This option render the PDF to an image 
before displayed providing a more accurate representation of the PDF 
in cases where the normal RimEngine rendering is incorrect. 

Enable Anti-Aliasing – Smooth edges of the rendering for better 
visibility. 
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Enable Render Page Size Limit – Prevent Render as image for PDF 
files larger than the selected paper size to prevent excessive use of 
resources. 

Map External True Type Fonts via Unicode – Setting to prevent a 
specific font handling problem. There is normally no need to change 
this setting. 

Disable Free Type Font Hinting – Setting to prevent a specific font 
handling problem. There is normally no need to change this setting. 

Stroke Adjust – Setting to prevent a specific line thickness rendering 
problem. There is normally no need to change this setting. 

8.1.11 Advanced Tab, Text 

 

Figure 30 Advanced Tab, Text 

This tab enables you to set the default font and other parameters for 
text files. 

Paper Size – Setup the page layout for printing. Use either default 
printer settings or select a different paper size. 

Select Size – Use this list box to set the default paper size to be used 
when displaying text files. 
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Select Font – Use this list box to set the default font style to be used 
when displaying text files. 

Enable Word Wrap – Check this box if you want words that extend 
beyond the end of the line to wrap to the next line. 

Tab Size – Set the tab size in number of spaces to control the size of 
a tab in a text file. 

8.1.12 Advanced Tab, VC5 

 

Figure 31 Filter Properties dialog, VC5 tab 

This tab enables you to set the location of AutoCAD font files so 
RxView can find them when necessary. If the AutoCAD font files are 
not found, text included in the drawing will not be displayed. Apply to 
CAD and Full versions only. 

In all cases: 

Click OK to accept the settings and close the dialog, click Apply to 
accept the settings and keep the dialog open, or click Cancel to close 
the dialog without implementing any changes. 
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8.2 Pen Table Dialog 
Apply to CAD and Full versions only. 

Typically in a vector file, lines have the same on-screen thickness but 
different colors. Colors can be interpreted to create printed output with 
different line thickness, colors and styles. Use the Pen Table dialog to 
define how you want a particular line color on the file to be printed or 
plotted. Change a single line or multiple lines by using standard 
Windows techniques to select them in the table then set the options as 
required. 

To open the Pen Table dialog, click the Pen Table button  or go to 

the Print dialog and click the Options button then select the Pen Table 
tab. 

 

Figure 32 Pen Table Settings dialog 

Check the Use Pen Table box if you wish to use the Pen Table 
function. The other options then become active. 
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Scale – Select Scaled if when you resize a drawing file you want the 
line widths to follow the scale of the drawing. Unscaled keeps the line 
widths constant irrespective of the scale of the drawing. 

Units – Select the units of measurement, metric (mm) or imperial 
(inches), you wish to use when defining line widths. 

Width – Set the desired printed width for the selected lines in the units 
defined in Units above. –1 indicates that no width has been defined for 
that pen. 

Style – Set the desired printed line style for the selected lines (full, 
dotted, dashed etc.). Default indicates that no line style has been 
defined for that pen. 

Color – Set the desired printed color for the selected lines. 

Change – Click to apply the changes to the file. 

Default - Click to return to the default settings. 

Load – Click to load a previously saved pen table (*.RPT) file. A Load 
Pen Table dialog opens to enable you to find and select the desired 
file. 

Save – Once you have made the desired changes to the pen table, 
save your table as an .RPT file so you can reuse the settings. A Save 
Pen Table dialog opens enabling you to name the file and place it in 
the appropriate folder. 

OK – Apply the changes and close the dialog. 

Cancel – Cancel the changes and close the dialog. 

Help – Click to obtain context-sensitive help. 
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8.3 File Information Dialog 
Click the Information button in the File Panel on the Home Ribbon to 
open the File Information dialog.  

 

Figure 33 File Information dialog 

File Type – The type of file, e.g. BMP, TIF, JPEG etc. 

File Folder – The path to the file. 

File Name – The full name and extension of the file. 

File Size – The file’s size. 

Image Width – The width of the image in the units defined for the file. 
This may be “pixels” in the case of raster files, “drawing units” for 
vector files etc. The value and units are defined when the file is 
created and are not affected by image calibration, filter settings, or by 
the zoom factor. 

Image Height – The height of the image in the units defined for the 
file. See Image Width above. 

Image Depth – For 3D images, the depth of the image in the units 
defined for the file. See Image Width above. 

Bits per pixel – The number of colors used expressed in number of 
bits to represent each color. 

Compression – The type of file compression used. 
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DPI – Dots per inch, the resolution of the file. 

Total Pages – Number of pages in multi page documents. 

Total Views – in vector CAD files. 

Total Sheets – in spreadsheets. 

Scaling – An internal factor for RimEngine relating the screen 
coordinate system with the file’s internal information. 

X-Offset – Information retrieved from file header. 

Y-Offset – Information retrieved from file header. 

Summary – Select this section to view the summary information for 

the file or any recognizable meta data. 

 

8.4 File Information Resources section 
The File Resources section shows any externally referenced 
resources in the current document, whether the resource is found, the 
resource name and the resource path used. 

 

 

Figure 34 File Information Resources 
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8.5 Find specified text dialog 
Click on the Find Text button in the Edit Panel on the Home Ribbon to 
open the Find dialog. 

 

Figure 35 Find text dialog 

This dialog enables you to search for text in documents and drawings. 

The located text will be highlighted. You can use the Match Word and 
Match Case options if you want to find only whole words or words with 
a specific mixture of upper and lower case characters. 

8.6 Find Markup Entity dialog (RxHighlight) 
Click on the Find Markup Text and Entities button on the Markup 

Ribbon>Tools Panel to open the Find Markup Entity dialog.  

 

 

Figure 36 Find text dialog 

This dialog enables you to search for markup entities by name or 
markup text based on a text search criteria. 
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8.7 Setting the Background Color 
When the file window is larger than the file image, the area outside the 
image but within the window frame will be given the selected 
background color. RxView provides a choice of three standard colors; 
white, black and gray, and allows you to create your own color as a 
fourth choice. 

Change the background color using the following methods: 

Click the Toggle Background Color button  on the Tools 
Ribbon>File Panel – each click toggles the color to the next of the four 
choices. 

Go to the active file right-click menu and click the Toggle Background 
Color item – each click toggles the color to the next of the four 
choices. 

Note  Only the active file’s background color will be changed. Different 
files can therefore have different background colors. 

8.7.1 Choosing a Non-standard Background Color 

Choose a non-standard background color as follows: 

1. Select the Options button on the Settings Ribbon>Settings Panel 
or click Options in the active file right-click menu. 

2. On the General tab click the Custom color picker option. 

3. Pick a standard color from the presented color chart. 

4. Click Apply or OK to implement the change.  

8.7.2 Create a Custom Color 

1. Select the Options button on the Settings Ribbon>Settings Panel 
or click Options in the active file right-click menu. 

2. On the General tab click the Custom color picker option and click 
Other to open a standard Windows color selection dialog. 

3. Once you have the desired color in the Color / Solid box, click 
Add to Custom Colors, and the color will be added to the Custom 
Colors table. 

4. Click OK to return to the chart of standard colors. 

Your new color is now included in the chart and is automatically 
selected in the Custom Color Picker in the Options dialog. 

5. Click Apply or OK to implement the change. 
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Your color is included as the Custom choice in the list of four 
colors in the Toggle Background Color command. 
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Chapter 9 Printing Files 

9.1 Print Dialog 
Click on the Print button on the Home Ribbon>File Panel to open the 
Print dialog. Before using the Print dialog you can use the Print 
Preview setup to prepare your print. You can also select print from the 
RxView Button menu. 

9.2 Print 
Print offers a standard Windows print dialog.  

 

Figure 37 Windows Print dialog 

This dialog enables you to select the required printer and the required 
pages to be printed. 

Options – Opens the Options dialog with the possibility to pick an area 
to print. 

Preview – Preview opens the preview dialog 

Print – Sends the file to the selected printer. 

Cancel – Cancels the print operation and returns to the file. 

Refer to Windows documentation for further details about printing. 
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9.3 RxView Button Menu Print 
The sub menu items of the Print item on the RxView button menu has 
4 sub menus. 

Print - Offers a standard Windows print dialog as described in chapter 
9.2. 

Print Setup - Offers a standard Windows print setup dialog where you 
can select printer, paper size and orientation. 

Print Preview - Changes the display to the Print Preview window, 
enabling you to see the image, as it will appear on paper before you 
print it out. 

Send File Directly to Printer - Printer file formats like HPGL can be 
sent directly to the printer as they are already in a printer format. Some 
printers also support raster formats like tiff directly. Use this function to 
bypass the printer driver and send the printer data directly to the 
printer. 

9.4 Print Preview 
This function opens a preview window and displays the active file as it 
will appear on the paper when you print it out. Proceed as follows: 

1. Select the file you wish to preview. 

2. Start the Print Preview function using one of the methods listed 
below. 

The RxView window changes to the RxView Print Preview 
window, and the active file is displayed. 

Note  If the active file is a multipage file, the preview window will 
automatically present the currently open page. If the 1 Page / 2 
Page function is set to 2 Pages, the currently open page and the 
following page will be presented. 

3. When you have finished previewing the file, click the Close button 
to return to the normal RxView screen layout. 

This function is activated using the following methods: 

Click the Print Preview button on the File Ribbon>Print Panel 

Select the Print > Print Preview menu option from the RxView button 
menu. 
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Select Print Preview from the active file’s right-click menu. 

Return to the normal RxView screen layout by clicking the Close 
button. 

The Print Preview Ribbon contains the following buttons: 

 

 

 Print – Sends the file to the selected printer. 

 

 Zoom In / Zoom Out – These buttons enable you to zoom in and out 
to the preview image for closer inspection. The function has three 
levels of zoom. Note that you can put the cursor onto the preview 
image and click left mouse to toggle through the three zoom levels. 

 

 Two Page – Toggle this button to view a single page or two pages. 

 

 Toggle Layout – Toggles between landscape and portrait print 
preview. 

  

 Page Options – Opens the Page Options dialog. See Chapter 9.5 for 
details.  

 

Printer Setup – Opens a standard Windows print setup dialog where 
you can select printer, paper size and orientation. 

 

Page Sizes – Opens a dialog where you can select paper size and 
orientation for the currently selected printer. 

 

Next and Previous page – If the active file is a multipage file (e.g. a 
document), use these buttons to move through the pages to ensure all 
will print out as expected. The buttons will be inactive if the file 
comprises a single page or if there are no more pages in the relevant 
direction. 
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Close – Closes Print Preview and returns to the RxView window. 

9.5 Page Options 
The Options > Print tab enables you to select the area of the image 
you want to print, position the printed part on the page, and add a 
watermark if required. Click the Print button or the Print Preview button 
and then click the Options button on the Print dialog. 

 

Figure 38 Page Options dialog 

Print portion 

Entire page/image – Select this option if you wish to print out the 
entire page/image irrespective of what is currently displayed in the 
RxView file workspace. 

Displayed portion – Select this option if you wish to print out only that 
part of the page/image that is currently displayed in the RxView file 
workspace. 

Limits – Apply to AutoCAD files. Use the AutoCAD limit value to 
define the printed area. 
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Selected Area – Use the Select Area to print function on the RxView 
File->Print Options menu to define a print area using the mouse. This 
option will then be automatically selected. 

 

Print control 

Maintain aspect ratio – Check this box if you wish to maintain the 
aspect ratio of the image in the printout. 

Poster – Check this option, then input the number of pages 
horizontally and vertically you wish the poster to be printed over. 

Monochrome – Check this option if you want the image to be printed 
in monochrome. 

Force Raster Printing – Force RxView to send bitmap data to the 
printer. Use this to ensure correct printing result. This will normally 
cause the amount of data sent to the printer to increase. 

Markup Only – Check this option to only print markup without the 
main file. 

Rotation – Select the appropriate rotation angle from this drop down 
list if you want to rotate the printed image relative to the selected paper 
orientation. 

Print scale 

Standard – Select this option then select a scale from the pull-down 
list if you wish to use a standard scaling factor. 

Scaled from – Select this option then add the desired scaling factors 
to the fields if you wish to use a non-standard scaling factor. 

 

Print offset 

Standard – Select this option then select an offset from the pull-down 
list if you wish to position the image in a standard location on the 
paper. 

Custom – Select this option then add the desired offsets to the X and 
Y fields if you wish to position the image in a non-standard location on 
the paper. The red square indicates the position of the image on the 
paper. 
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Click Apply to implement changes and keep the print tab open, click 
OK to implement changes and close the tab, click Cancel to close the 
tab without implementing any changes, and click Help to access the 
on-line help system. 
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9.6 Print Watermark  
You can add a watermark to the printout, for example to simplify 
identification of the paper or add a date stamp. Go to the RxView Print 
> Options button. Select the Watermark tab to display the dialog 
below. 

 

Figure 39 Page Options > Watermark tab 

 

Enable watermarking – Check this box to enable the watermarking 
function. All other options on the dialog will be inactive until this box is 
checked. 

Watermark type – Select Text or Image. You cannot use Text and 
Image watermark at the same time. 

Draw Order – Select In Front to print the image first then print the 
watermark on top of the image (so you can be sure of seeing all the 
watermark). Select Behind to print the watermark first then print the 
image on top of the watermark (so you can be sure of seeing all the 
image). 
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Alignment – Select how you want the watermark text to be positioned 
on the page. 

Vertical position – Select where you want the watermark text to be 
positioned on the page. 

 

Text Options 

Transparent – Allow you to add a transparent custom text. When 
using transparent custom text File Path, File name, Date, Time and 
Multiple lines options are not available. 

Custom text – Check this option to allow custom text in the 
watermark. Once you have checked this box, you can then type the 
desired text into the field. Any number of characters can be included in 
this field. Note however that if the text is wider than the image, the text 
will be truncated at the edge of the image. 

File Path – Check this option to add the file path to the watermark. 

File Name – Check this option to add the file name to the watermark. 

Current date / time – Check these options to add the current date and 
time to the watermark. The date and time will be that which is valid 
when you click the Apply button on the watermark dialog. 

Multiple lines – Check this box to place the file path and name, the 
date, and any custom text, on separate lines in the watermark.  

You can add the file path, file name and date/time to the custom 
text by using the codes as follows (note that the letters are case-
sensitive): 

 Type %p to include the file path. 

 Type %f to include the file name. 

 Type %d to include the current date. 

 Type %t to include the current time. 

Note  You can fit more text into the image by reducing the font size or 
by positioning the text parallel to the long edge of the image. 

Note  Any custom text will always be restricted to one line of text. 

Orientation – Select the angle at which you want the watermark text 
to be positioned on the page. 
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Font options – Click this button to open a standard Windows font 
selection dialog. Click Close in this dialog to return to the Watermark 
tab. 

Image Options 

Image Filename – Browse for an image file to use as a watermark. 

Scale – Set the scale to define the size of the image on the paper. 

Transparency – Set the transparency in percent. 

 

9.7 Print Header and Footer  
You can add headers and footers to the printout, for example to 
simplify identification of the paper or add a date stamp. The text will be 
written above or below your image and not across the image as in 
Watermark. Go to the RxView Print > Options button. Select the 
Header and Footer tab to display the dialog below. 

 

Figure 40 Page Options > Header and Footer tab 
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Enable header – Check this box to enable the header function. 
Options on the dialog will be inactive until this box is checked. 

Enable footer – Check this box to enable the function. Options on the 
dialog will be inactive until this box is checked. 

Text and codes – Write your header or use codes to create dynamic 
headers and footers as described in the Watermark section. 

9.8 Print Pen Table  
You can add pen table settings to the printout if the file can use pen 
table settings. Go to the RxView Print > Options button. Select the Pen 
Table tab to display the dialog below. Apply to CAD and Full versions 
only. 

 

Figure 41 Page Options > Pen Table tab 

Read about pen tables in the previous chapter. The dialog reached via 
Print > Options is identical. 
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9.9 Printer Setup and Page Sizes 
Before printing the active file, open the Printer Setup dialog to select 
printer and then select the Page Sizes dialog to configure the page 
layout. Access the Page Sizes dialog as follows: 

Via the active file right-click menu  

In the Print Preview window, click the Page Sizes button. 

 

Figure 42 Page Setup dialog 

Size – Click the down arrow and select a paper size from the pull-
down list. 

Source – The selected printer’s driver will automatically present the 
available paper trays in the pull-down list. Select the desired paper 
source. 

Orientation – Select the required paper orientation. The options are 
Portrait or Landscape. 

Margins – Type in the required margins. 

 

Click OK to close the Page Sizes  dialog and implement the changes. 
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9.10 Printing 
When you start the printing function a standard Windows Print dialog 
opens. This enables you to select the required printer and set it up, 
and select the required pages to be printed. 

Options – Opens the Options dialog. See paragraph Print Options for 
further details. 

OK – Sends the file to the selected printer. 

Cancel – Cancels the print operation and returns to the active file. 

Refer to your Windows documentation for further details about the 
Print dialog. 

 

Note  If the active file contains several layers, only those layers that 
are displayed will be printed. 
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Chapter 10 Special Functions 

10.1 Extract Text (RxHighlight) 
Extract Text function enables you to extract all the text from a drawing 
or document that contain readable text. 

 

Figure 43 Text Extraction dialog 

Save – Save the text to a text file. 

Clipboard  – Copies the extracted text to the clipboard. 

Extract – Extracts text if any from the current file. 

Close – Close the Batch Print dialog. 
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10.2 Batch Print (RxHighlight) 
Batch Print function enables you to print multiple files as a Batch job. 
Selecting this function from Tools Ribbon will open the dialog 
displayed below. 

 

Figure 44 Batch Print dialog 

Use the buttons in the dialog to create and start a batch job. 

Start – Start the batch process with the current batch list. 

Close – Close the Batch Print dialog. 

Add Files – Add files to the batch print list. 

Add Folder – Add a file mask for a given folder to the batch print list. 

Remove – Remove the selected file from the batch print list. 

Save List – Save the current batch print list to a file. 

Load List – Load a previously saved batch list from file. 

Page Setup  – Opens the Page Sizes dialog. 

Printer Setup  – Opens the Printer Setup dialog. 
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Right click menu 

You can modify lines in the batch print list using a menu. Bring up the 
menu by right clicking in the batch print list. 

 

Figure 45 Batch Print dialog menu 

All pages – Print All pages in the selected file. 

First Page – Print only the first page in the selected file. 

Copies – Set the number of copies you want printed of the selected 
file. 

Edit File Mask – If a folder is included in the batch list, you can set a 
file mask for this folder. Only files in the folder matching the mask will 
be included in the batch job. 

Include Markup 

Check this check box if you want markup to be included when printing 
the files. 

Use Pen Table 

Check this check box if you want to use a predefined pen table file for 
the batch print job. You can select a pen table file using the browse 
button next to the pen table file path field. 

10.3 Batch Conversion (RxHighlight) 
Batch Conversion function enables you to convert multiple files as a 
Batch job. Selecting this function from the file menu will open the 
dialog displayed below. 
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Figure 46 Batch Conversion dialog 

Set up the batch job using the functions described below. 

Destination format  – Select from the available formats in this list. 
Raster files cannot be converted to vector formats. 

Rasterize – Check this if you are converting to a raster format. 

Destination folder  – Select the target folder where you want to save 
the result of the conversion. 

Use Pen Table  – If you want to use a pen table setting for the source 
files you can check this check box, and select an existing Rasterex 
Pen table file using the field and browse button next to it. 

Add Files – Add files to the batch print list. 

Add Folder – Add a file mask for a given folder to the batch print list. 

Remove – Remove the selected file from the batch print list. 

Save List – Save the current batch print list to a file. 

Load List – Load a previously saved batch list from file. 

Start – Start the batch process with the current batch list. 

Close – Close the Batch Print dialog. 
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Raster Settings – This is used only if the target format is a raster 
format. It is the same dialog as described later in chapter Saving to 
raster. 

Include Markup – If there is markup associated with the drawing and 
you are converting to a raster format, you can check this to include the 
markup in the target file as a part of the raster. 

 

10.4 AutoCAD Batch Conversion (RxHighlight) 
AutoCAD Batch Conversion function enables you to convert multiple 
AutoCAD files to other AutoCAD file versions as a Batch job. Selecting 
this function from the file menu will open the dialog displayed below. 

  

Figure 47 AutoCAD Batch Conversion dialog 

Set up the batch job using the functions described below. 

Destination format  – Select from the available formats in this list.  

Destination folder  – Select the target folder where you want to save 
the result of the conversion. 

Add Files – Add files to the batch print list. 

Add Folder – Add a file mask for a given folder to the batch print list. 
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Remove – Remove the selected file from the batch print list. 

Save List – Save the current batch print list to a file. 

Load List – Load a previously saved batch list from file. 

Start – Start the batch process with the current batch list. 

Close – Close the Batch Print dialog. 
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Chapter 11 Viewing Functions 

 

11.1 Zoom using mouse wheel 
If you have a mouse with a wheel you can zoom in and out of drawings 
by rolling the wheel forward and backwards. 

 

11.2 Zoom slider 
Zoom Slider function enables you to zoom the active file in or out by 
using a slider button. When this function is accessed, the Zoom Slider 
dialog opens. 

 

Figure 48 Zoom Slider dialog 

When you open the Zoom Slider dialog, the slider button is positioned 
at the current zoom factor. The current zoom factor is shown in the 
Zoom Scale field. To set the zoom factor: 

Drag the slider button to the desired zoom factor, or If your mouse has 
a wheel, roll the wheel towards and away from yourself to move the 
slider to the right and left respectively. Or, :Type the desired zoom 
factor into the Zoom Scale box and press Enter on your keyboard. 

The zoom slider zooms the image from 1/10 to 10x the image’s 
current extent size (compared to the window), in increments of 0.1x. 

Check the Update Dynamically box if you want the image to be 
updated while you are moving the zoom slider. 

Click Done to terminate the dialog. 
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The function maintains the image’s aspect ratio. If the image is too 
large to fit in the window after zooming, pan sliders will be displayed. If 
the resulting image is narrower than the width of the window, the 
image will be centered horizontally in the window and the excess area 
will be given the background color. 

11.3 Zoom All State 
Activate this function using the Zoom All State menu item on the Zoom 
All drop down menu to tie the image size to the window size. As you 
adjust the size of the window the image will automatically enlarge or 
reduce to keep the image as large as possible within the window while 
maintaining the image aspect ratio (the ratio of width to height). 

11.4 Scrolling and Panning 
RxView allows two methods of scrolling images (moving the image 
within the viewing window such that areas of the image lying outside 
the window can be viewed): 

The scroll bars. 

The pan hand. 

11.4.1 The Scroll Bars 

The scroll bars appear below and/or to the right side of the viewing 
window if the image is too wide or too tall to fit in the window. Use the 
scroll bars as follows: 

Put the cursor onto the appropriate square slider button, click and hold 
the left mouse button, and drag the slider horizontally or vertically 
along the bar. The image moves past the window. Release the left 
mouse button when the desired part of the image is in view. 

Put the cursor onto one of the arrow buttons located at both ends of 
the scroll bars and click the left mouse button repeatedly. For each 
click of the mouse button the image will step past the window in 
increments of 1/100 of the vertical or horizontal dimension of the 
image. I.e. 100 clicks of the mouse button will move the slider from 
one end of the scroll bar to the other – the distance the image moves 
for each step will depend on the ratio of the image size compared with 
the window size. 
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Put the cursor onto one of the arrow buttons located at both ends of 
the scroll bars and click and hold the left mouse button. The image will 
step automatically past the window in increments of 1/100 of the 
vertical or horizontal dimension of the image. The scroll slider moves 
from one end of the scroll bar to the other in approximately five 
seconds – the speed of movement of the image will depend on the 
ratio of the image size compared with the window size. 

Put the cursor into the scroll bar to one side of the slider button and 
click the left mouse button. For each click of the mouse button the 
image will step past the window in increments of 1/10 of the vertical or 
horizontal dimension of the image. I.e. 10 clicks of the mouse button 
will move the slider from one end of the scroll bar to the other – the 
distance the image moves for each step will depend on the ratio of the 
image size compared with the window size. 

11.4.2 The Pan Hand 

The Pan Hand button toggles the pan function used to view parts of an 
image that are outside the window by grabbing the image and moving 

it. To use the function Click the Pan Hand button  on the Home 

Ribbon>View Panel: 

1. Activate the function using one of the methods listed below. The 
Pan Hand cursor appears. 

2. Place the cursor onto the image. 

3. Click and hold the left mouse button. The hand cursor closes and 
grips the image. 

4. Drag the image around inside the window until the desired part of 
the image is in view. Once you can view the edge of the image 
you cannot drag the image further in that direction.  
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11.5 Rotating Images 
Within RxView there are three methods of rotating images: 

The Angle buttons (not available with 3D images).  

The Rotation Slider.  

The Toggle Rotate State  

11.5.1 The Angle Buttons 

Use these buttons to rotate the active image clockwise to 0°, 90°, 180° 
and 270° degrees. 

Note  This function is not available for 3D image files. 

This function is activated and deactivated using the following methods: 

Click one of the Angle buttons  on the Home 

Ribbon>View Panel to set the angle. 

Put the cursor in the active window and click the right mouse button. 
Select Toggle Rotation Angle in the pull-down menu to step through 
the preset 90° angles. 

11.5.2 The Rotation Slider 

Use this function to rotate the active image clockwise through 1° steps 
using a slider bar. When this function is selected one of two possible 
dialogs is displayed depending on the type of file in the active window. 

This function is activated using the following methods: 

Select the 
 

Rotation Slider button on the Home Ribbon>View 

Panel. 

One of the following dialogs opens depending on the file type: 

11.5.2.1 Rotation Slider Dialog 

Note  Two dialogs are available; one for 3D files and one for all others. 
Refer to chapter 3D Files for details about the 3D dialog. 

When you open the Rotation Slider dialog, the slider will be positioned 
at the current rotation angle. The current rotation angle is shown in the 
Rotation Angle field. 
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Figure 49 Rotation Slider dialog for all types of files except 3D 

Check the Update Dynamically box if you want the image to be 
updated while you are moving the rotation slider. Drag the slider button 
to the desired rotation angle. Or, type the desired rotation angle into 
the Rotation Angle field. The rotation can be set to any angle between 
0° and 359°, in steps of 1°. Click Done or press ESC to close the 
dialog. 

11.6 Creating a Mirror Image of a File 
Using the Flip function you can create a mirror image of the active file. 
The file can be mirrored about its vertical and horizontal axes. 

Right-click on the active file and select Flip > X or Y. 

Click on the Flip X  or Flip Y 
 

buttons on the Home 

Ribbon>View Panel. 

The current zoom magnification is maintained. 

 

11.7 Editing Files 
You can edit the active file if the file extension is associated with a 
suitable editing application. 

Select the Edit button on the Home Ribbon > Edit Panel  to start 

the associated application and open the active file. 

11.7.1 Setting the Edit Application 

Set the edit application for the active file as follows: 
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Open the Filter Settings dialog either by clicking the Filter Settings 
button or by selecting the Filters button on the Tools Ribbon. In the 
Edit Application field, type in the path and .EXE file name of the 
application you wish to use to edit the currently selected file, for 
example RxSpotlight. 

Or: 

Click the browse button beside the field and browse to the application. 
Once the required application is displayed in the Edit Application field, 
click Close. All files with the same file extension as the currently active 
file will hereafter be associated with the selected editing application. 

11.7.2 Editing the File 

Refer to the edit application’s documentation for information about 
editing the file. 

11.8 Magnifying 

11.8.1 The Magnifying Glass 

Click the Magnifying Glass button on the Home Ribbon>Tool Panel to 
magnify a part of the active file and display the enlarged part in an 
area in front of the file. 

Click the Magnifying Glass button on the Home Ribbon>Tool Panel. 
Select the shape of the enlarged area from the button drop down 
menu.  

Set the magnifying scaling factor in the Tools > Options > General tab 
dialog.  

11.8.2 The Magnifying Window 

Click the Magnifying Window button on the Home Ribbon>Tool Panel 
to magnify a part of the active file and display the enlarged area in a 
new window. 

Set the magnifying scaling factor in the Tools > Options > General tab 
dialog. 

11.9 Bird’s Eye View 
The Bird’s Eye View function provides an overview of the file, and 
allows you to pan around and select areas to zoom. 

Click the Bird’s Eye View button Home Ribbon>Tool Panel. 
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Overview of an image 

Activate the function and a total view of the file contents appears in the 
Bird's Eye View window. Change the size of the Bird’s Eye window by 
dragging its borders. 

Zooming 

Place the cursor inside the Bird's Eye View window and press the right 
mouse button. Drag the mouse diagonally to create a frame that 
marks the area you want to zoom into. Release the right mouse button 
and the selected area zooms to fit the file’s view window. 

Panning 

The red indicator frame inside the Bird's Eye View window is 
superimposed over the part of the file currently visible in the file 
workspace. Place the cursor inside the red frame, click and hold the 
left mouse button, and drag the cursor until the frame encloses the 
information you wish to see. As you do so, the view in the work area 
changes to match the area enclosed in the frame. 

11.10 Copying Part of an Image to the Clipboard 
You can select part of an image and copy it to the Windows clipboard. 
From the clipboard you can then paste the image part into another 
application. 

Select Bitmap, Metafile or Text from the Home Ribbon>Clipboard 
Panel. The cursor changes to the Copy to Clipboard format. Put the 
point of the cursor on one corner of the area to be copied, click and 
hold the left mouse button, and drag the mouse to create a rectangle 
around the area to be copied. Release the left mouse button to copy 
the defined area to the Windows clipboard. 

The marked area is placed on the Windows clipboard in the selected 
format. You can now move to another application and select Paste to 
paste the copied area into that application. 

Metafile format is a vector format. 

Bitmap format is raster format. 

Text format is ascii text. 
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11.11 Multipage and office format functions 

11.11.1 One Page View 

The One Page View button  displays the current page of the 

multipage file in the file window. This is default. 

11.11.2 Thumbnail View 

Click the Thumbnail View button  to display all the pages in the file 

(as many as will fit in the window) as thumbnail images. Horizontal and 
vertical pan sliders are displayed as required. The rows and columns 
of images are rearranged to fit as you resize the window. The page 
numbers are displayed below each page. 

Place the cursor in the window but not on a thumbnail then click the 
right mouse button to get a reduced menu, or place the cursor on a 
thumbnail and click the right mouse button to select that page and get 
a full menu. 

11.11.3 Page and Thumbnails View 

Click this button  to split the file window and display both the 

thumbnails and the current page. Use the vertical pan slider to move 
through the thumbnails, and click on the required page. 

The Thumbnails right-click menu functions in the thumbnails column 
as described in the previous paragraph, while the standard Active File 
right-click menu functions in the file display area (see paragraph Active 
File menu for details). 

11.11.4 Paging Through a Multipage File 

Use the Page Up button  and the Page Down button  to move 

through the multipage file. You move one page for each click of the 
button. The button is deactivated when there are no more pages in 
that direction. 

 

The Page List box  indicates which page of the multipage file 

is currently displayed. 

Type the required page number into the box and press Enter. 

Or: 
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Click the arrow button beside the box to display a pull-down list of the 
available pages. Then click on a page in the list to display that page 
and close the list. 

Note  Many of the menu options are file-type-dependant, i.e. the menu 
options available at any particular time will depend on the type of file 
that is active at that time. This chapter lists and describes all the 
possible menu options that may be available in RxView. 

11.12 View > Full Screen 

Use this Button  in the upper right corner of RxView window to 

toggle the current file to display full-screen. While the file is displayed 
full screen the Toggle Full Screen button will be displayed in the upper 
left corner. Click the button to return to the “normal” layout. 
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11.13 Window > Split 
The active file’s window can be split into four areas to enable you to 
view different areas of the same image at different magnifications. 
Once you have split the window into four, you can move the vertical or 
horizontal dividers as required to resize the sub-windows. 

If you move one of the dividers to the edge of the window, the divider 
will disappear, giving two sub-windows. Re-select the Window > Split 
menu item to return to four sub-windows. 

All zoom, pan and viewing functions operate individually on the 
different parts of the split window. 

11.14 Window > Windows 
The Windows button on the Tools Ribbon>Windows Panel opens the 
Windows dialog. This dialog lists the files that are currently open in the 
viewer, in the order in which they were last active, with the currently 
active file at the top of the list. 

Note  Set the maximum number of files to be listed in the Options 
dialog. See paragraph General Tab for further details. 

Use standard Windows techniques to select files on the list. The 
buttons are as follows: 

 

Figure 50 Windows dialog 
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Activate – Activates the selected file and closes the dialog. Only one 
file can be active; if more than one file is selected the Activate button 
is grayed out. 

OK – Click OK to close the Windows dialog once you have finished 
using it. 

Close Window(s) – Closes the selected files. 

 

11.15 Right-click Menus 

11.15.1 List Bar Menu 

Place the cursor in a clear part of the workspace frame on the right or 
below the workspace, and click the right mouse button to display a 
pull-down list of the options available. These are as follows: 

Block List Bar – Select this item to display the Block List Bar. 

File Explorer List Bar – Select this item to display the File Explorer 
List Bar. 

Folder Explorer List Bar – Check this item to display the Folder 
Explorer List Bar. 

Layer List Bar – Check this item to display the Layer List Bar. 

Markup List Bar – Check this item to display the Markup List Bar. 

Markup Symbol List Bar – Check this item to display the Markup 
Symbol List Bar. 

Page List Bar – Check this item to display the Page List Bar. 

Note  The File Explorer and Folder Explorer List Bars are 
interlinked as follows: 

 The folder explorer window can be toggled on and off while 
the file explorer is on. If the folder explorer window is off, the 
folder explorer functions (folder browse etc.) then become 
available through the file explorer window. 

 If you toggle off the file explorer window, both the file 
explorer and folder explorer windows will toggle off. 

 You can toggle the folder explorer off, and then toggle the file 
explorer on and off separately. 
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 If both the file and folder explorers are off, you can toggle 
both on by checking the Folder Explorer option. 

11.15.2 Folder Explorer Menu 

Note  The folder explorer can be switched on and off separately.  

 The folder explorer can be resized as required on the 
screen. To resize the bar, place the cursor on the bar’s 
frame then click and hold the left mouse button and drag the 
frame. Release the mouse button when the bar is the 
desired size. 

11.15.3 File Explorer Menu 

Place the cursor in a clear part of the file explorer (not on a folder 
name) and click the right mouse button to display a pull-down list of 
the options available. These are as follows: 

 

Large Icons – Check this option if you wish to display the files as 
large icons. The icon used will depend on the type of file. 

Small Icons – Check this option if you wish to display the files as 
small icons. The icon used will depend on the type of file. 

List – Select this option if you wish to display the files in a list. 

Details – Check this option if you wish to display the file details. When 
Details is selected, several new options become available: 

 Place the cursor in the file explorer button bar and click the 
right mouse button to display a pull-down list of the file 
details available. Check/uncheck the items in the list to 
show/hide the file detail columns. 

 The file detail columns can be moved and sized as required. 
To move a column, place the cursor onto the appropriate 
button, click and hold the left mouse button, then drag the 
button to the required place in the button bar and release it. 
You will notice that as you drag the cursor, the nearest 
“space” between the buttons turns blue to indicate where the 
dragged button will be located when you release it. 
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 The files listed can be sorted by name, size, file type, 
modification date and attributes, in either direction (up or 
down). Click on the appropriate column button to select the 
desired sort method. Click the same button again to toggle 
the direction (note the arrow indicating the sort direction). 

Thumbnails – Check this option if you wish to display the files as 
thumbnail images. When this option is selected, the Preview option is 
inactive. 

Show Preview – Check this option if you wish to display a thumbnail 
preview of the selected file beside the file explorer. If several files are 
selected, only the last selected file will be displayed in the preview 
window. 

The file names can be displayed in the explorer in a variety of ways: 

Note  The Folder explorer can be switched on and off separately. 

 

11.15.4 Active File menu 

Place the cursor in the active file window and click the right mouse 
button to display a pull-down list of the options available. Note that the 
options will vary depending on the type of file that is active. The 
possible options are as follows: 

Zoom – Put the cursor onto this item to display a submenu of the 
various zoom functions available.  

Rotate – Put the cursor onto this item to display a submenu of the 
various rotation functions available.  

Flip - Put the cursor onto this item to display the two choices available 
for flipping the image (creating a mirror image); X flips the image 
around the horizontal axis and Y flips it around the vertical axis. 

Pan – Select Pan Hand from the menu to set the mouse in pan mode. 

Copy to Clipboard – Put the cursor onto this item to display a 
submenu of the various formats available to be used to copy a 
selected part of the image to the Windows Clipboard. Select the 
required format to start the copying process. 

Measure – Put the cursor onto this item to display a submenu of the 
various items available under the Measure function. Refer to 
paragraph Measuring Distances, Angles and Areas for further details. 
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Entity Information – For CAD files you can use this function to get 
information on drawing entities you click on in the drawing. 

Toggle Background Color – Click this option to toggle the 
background color through the four choices. Refer to paragraph File 
Information Dialog for further details. 

Page Setup – Click this option to display the Page Setup dialog. Use 
this dialog to set the page margins, paper size etc. Refer to paragraph 
Print Dialog for further details. 

Print Preview – Click this option to display the Print Preview dialog. 
Refer to paragraph Print Options for further details. 

Print – Click this option to open the Print dialog. 

Options – Click this option to open the Options dialog. Refer to 
paragraph Setting Up the RxView Options for further details. 

Help – Opens the RxView on-line help system. 

Note  The Active File right-click menu is deactivated while the Zoom 
In/Out function is active.  

11.16 Function Keys 
Two keys on your keyboard can be used to toggle functions. These 
are as follows. 

11.16.1 F8 Key 

The F8 key toggles the Ortho mode. This mode restricts calibration 
and measurements to the vertical and horizontal axes. The Ortho 
mode can be toggled on and off at any time during a measurement 
procedure. See paragraph Orthogonal for further details. 

11.16.2 F9 Key 

The F9 key toggles the Snap mode. See paragraph Snap for further 
details. 
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Chapter 12 Calibration and Measurement 

12.1 Measuring Distances, Angles and Areas 
Toggle the Measure function by clicking the Measure button on the 
Home Ribbon>Tools Panel. 

Note You may have to calibrate your image first. See this chapter. 

The Measurement function enables you to measure the length of a 
line, the angle between two lines, or the area enclosed by multiple 
lines, on the active file. The results - Distance, Angle, Area, 
Accumulated distance - are displayed dynamically in a tool tip window, 
and will also be displayed in the Measurement Statistics dialog (see 
this chapter). 

The results are displayed using the active measurement units for the 
particular file type. 

An Orthogonal function is available which restricts the measurements 
to the vertical or horizontal axes. 

A Snap function is available to assist with accuracy when measuring to 
and from particular points on a line. See next paragraph for further 
details. 

The results from the Measurement Statistics dialog can be copied to 
the clipboard then pasted into another application or document. 

12.1.1 Snap 

The Snap function improves accuracy when measuring vector 
drawings. The cursor snaps to defined points (nodes) on the nearest 
line when the cursor moves within a pre-defined range of the node. 
The defined nodes are Nearest, End point, Middle point, and Center, 
and each type of node has a particular cursor shape to indicate the 
node type. 

You can toggle each type of snap node on or off individually in the 
Settings Ribbon > Settings Panel >Options Dialog  > Advanced tab or 

using the Snap settings drop down menu on the status bar . 

F9 key on your keyboard toggles the Snap mode as a whole.  

Settings Ribbon > Settings Panel >Options Dialog > General tab > 
Snap tolerance setting allows you to set the pixel snap range. 
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Note  If both the Ortho and Snap functions are activated, when a 
measurement is made that ends near but not on a designated snap 
point, the Ortho mode will automatically be toggled off to enable the 
Snap function to take precedence. 

12.1.2 Orthogonal 

The Orthogonal function restricts calibration and measurements to the 
vertical and horizontal directions in 45-degree steps. 

You can toggle the Ortho function either by checking the option in the 
Settings Ribbon > Settings Panel >Options Dialog > Advanced tab, 
through the Active File right-click menu under the Options option or 

using the ortho button on the status bar .  

F8 key on your keyboard toggles the Ortho mode as a whole.  

Note  If both the Ortho and Snap functions are activated, when a 
measurement is made that ends near but not on a designated snap 
point the Ortho mode will automatically be toggled off to enable the 
Snap function to take precedence. 

The Ortho mode can be toggled on and off at any time during a 
measurement series by pressing the F8 key on your keyboard. 

12.1.3 Measurement Statistics Dialog 

When you have finished measuring an object, angle or area, use 
mouse double click at the last point to stop the function and open the 
Measurement Statistics dialog. This dialog, an example of which is 
shown below, displays the results 



 

 

146 

 

Figure 51 Measurement Statistics dialog 

Point – The points you have clicked. 

Angle – The angles between the lines created. 

Distance – The distances between the points, in the units of 
measurement defined in the Tools > Filter Setup > Options tab for the 
particular file type. 

Measured Distance – The total distance of all the current 
measurement operations. You can select the units of measure in the 
drop down list to the right. 

Measured area – The area generated by the last measurement 
operation. You can select the units of measure in the drop down list to 
the right. 

Measured Perimeter – The perimeter of the currently measured area 
generated by the last measurement operation. You can select the units 
of measure in the drop down list to the right. 
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Accumulated area – The total area generated by all the measurement 
operations since the last time the Clear Accumulated button was 
pressed. 

Accumulated Distance – The total distance of all the measurement 
operations since the last time the Clear Accumulated button was 
pressed. 

Clear Accumulated – Resets the accumulated totals to zero. 

Copy – Copies the measurements and accumulated totals to the 
Windows clipboard so you can paste them into another application as 
a list. The list has tab delimiters between fields so the text can be 
pasted and converted to a table in Word or pasted directly into an 
Excel spreadsheet. 

Export – Exports measurements to a comma separated text file. 

OK – Closes the Measurement Statistics dialog. 

 

12.1.4 Measuring the Length of an Object 

1. Zoom in to the image to achieve the appropriate accuracy, click 
the Measure button and move the cursor to one end of the object 
to be measured. 

2. Click the left mouse button, move the cursor to the other end of 

the object and click the left mouse button. An arrow forms behind 
the cursor as you move it, indicating the start point and current 
end-point of the measurement line. Press ESC on the keyboard to 
access the Measurement Statistics dialog. 

The Measurement Statistics dialog is opened and displays the results. 
The results are presented dynamically in the status bar while the 
measurement function is in progress, and will be deleted from the 
status bar when a new function is selected. 

Note  You must toggle the Measure button off to switch off the 
measurement function. 

12.1.5 Measuring the Angle Between Two Lines 

1. Zoom in to the image to achieve the appropriate accuracy, activate 
the Measure function. Move the cursor to one end of the angle to 

be measured and click the left mouse button. 
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2. Move the cursor to the apex of the angle and click again, then 
move the cursor to the end of the other line such that the red lines 

define the required angle and click the left mouse button. Press 
ESC on the keyboard to access the Measurement Statistics dialog. 

The Measurement Statistics dialog is opened and displays the results. 
The results are presented dynamically in the status bar while the 
measurement function is in progress. The steps can be repeated as 
often as required, but only the angle between the last two lines is 
displayed in the status bar. All the angles are listed in the 
Measurement Statistics dialog. 

If the Display measurement dialog box option is selected in the Tools > 
Options > Advanced tab, the Measurement Statistics dialog will open 
and display the results. If the option is not checked in the Options 
dialog, the results will be presented dynamically in the status bar while 
the measurement function is in progress, and will be deleted from the 
status bar when the ESC key is pressed. 

Note  You must toggle the Measure button off to switch off the 
measurement function. 

12.1.6 Measuring an Area Enclosed by Multiple 

Lines 

1. Zoom in to the image to achieve the appropriate accuracy. Click 
the Measure button and move the cursor to a point on the 
boundary of the object to be measured. 

2. Click the left mouse button on the edge of the object to measure 
and move the cursor to the next point. 

3. Continue clicking points around the object until the object is 
completely enclosed. You can undo the last point by using the 
Backspace key on the keyboard. 

4. Press ESC on the keyboard to terminate the measurement. 

The Measurement Statistics dialog is opened and displays the results. 
The results are presented dynamically in the status bar while the 
measurement function is in progress, and will be deleted from the 
status bar when a new function is selected. 
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12.2 Calibrating an Image 
The Calibration function enables you to measure the length of an 
object on the active file and define a value for that measurement. The 
ratio of the measured distance to the defined distance is remembered, 
and thereafter any distances measured on that file will be multiplied by 
this scaling factor before being presented. The measurements are 
displayed using the units selected in the Filter Settings > Measure tab 
for the particular file type. 

Note  To calibrate a file, the units of measurement for that file must be 
set to a standard type, i.e. not System. If the Calibrate button is 
inactive, go to the Measure tab in the Filter Settings dialog and change 
the unit type. See chapter Filter Settings for further details about Filter 
Settings. 

Select the Calibrate menu item from the Measure button drop down 
menu on the Home Ribbon > Tools Panel. 

Snap mode and Orthogonal mode are available to improve accuracy. 
See previous section in this chapter for further details. 

Note  The Calibrate function switches off automatically once you have 
completed a calibration operation. 

1. Select the Calibrate menu item from the Measure button drop 
down menu on the Home Ribbon > Tools Panel. 

2. Activate the Ortho function if required (F8). 

3. Activate the Snap function if required (F9). 

4. Click the left mouse button on one end of the object and drag the 
arrow-headed line to the other end. The length of the connecting 
line is displayed dynamically in the status bar. 

5. Click the left mouse button to stop the line.  
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A dialog similar to that shown below is displayed: 

 

Figure 52 Measurement Calibration dialog 

6. Type into the data field the measurement you wish to use for the 
selected distance. 

7. Check the Set as default for all files of this type box if you wish 
the scaling function to apply to all files using the same filter. 

8. Click OK. 

Further measurements on this file will use the new scale. 

 

Note  Use calibration only when necessary. For most files setting up a 
measurement unit and scaling should be sufficient to get an accurate 
measurement. 
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Chapter 13 Overlay, Compare, Save As 

The Overlay feature allows you to overlay one or more files on a 
background file. Overlay files can be scaled and offset to match a 
background even if they have different scaling.  

The Compare feature allows you to compare two files. Typically, these 
files would be two revisions of a drawing compared so that the 
differences can be clearly seen. The differences are highlighted while 
identical features in the drawings are played down.  

Save As allows you to convert and save a drawing file (vector file or 
raster file) to a raster file format. Typically, CAD drawings can be 
saved to a non-editable format such as TIFF. You can also convert 
and save a selected drawing file (vector file only) to a vector file 
format. Typically, CAD drawings can be saved to a compact non-
editable standard plot format such as HPGL for distribution. 

 

13.1 Overlay 
Overlay allows you to load several files and display them in the same 
view window. Many files can overlay each other simultaneously. To 
overlay files, click the Compare and Overlay button on the Tools 
Ribbon > Compare Overlay Panel.  

(Overlay is a dynamic dialog. Changes to the overlay can be seen on 
screen as you work.) The result is displayed in a new window marked 
“Compare Window”. The settings applied to the overlay can be 
changed and saved. Load the saved overlay settings file (file extension 
is XWS) and you will re-create the overlay as it was last saved. There 
is no limit to the number of overlay files you can create.  

Note  All files to be overlaid or compared must already be loaded 
before you open the Overlay dialog.  

The Overlay and Compare dialog shows a list box. The list box shows 
all the currently loaded files. Only one of these files can be selected as 
the background image the other files will be overlay files.  
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Figure 53 Overlay Selection dialog 

How to overlay files 

1. Load the files that you want to overlay or compare and then click 
the Compare Files button on the Home Ribbon > Overlay 
Compare Panel.  

2. In the Document Overlay and Compare dialog select a 
background file in the list box on the left. Click the Select 
document as: > Background radio button. 

The selected file is the background image. Only one file can be 
set as background. Background files have state “B”. 

3. Select an overlay file in the list box on the left. Click the Select 
document as: > Overlay radio button. 

The selected file is the overlay image. You can have multiple 
overlay files. Overlay files have state “O”. 
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The Display Color allows setting of colors. Overlay files will 
normally use the original file colors and the overlay files are 
displayed transparently on top of the background file as a hybrid. 
In Compare mode, the overlay file is displayed on top of the 
background file with an XOR function. This means that any 
differences between the two drawings are best displayed in a 
different color. In Compare mode, different Display colors are 
automatically selected for the active files. 

4. The Display Mode offers Overlay or Compare radio buttons. The 
paragraph above described the difference between Overlay and 
Compare modes. 

5. The Scale entry field allows you to type in an exact scale of the 
overlay image in relation to the background image. 

6. Rotation allows an overlay image to be rotated by selecting the 
desired angle of rotation, 0, 90, 180 and 270 in the Rotation field. 

7. The X-Offset and Y-Offset entry fields allow you to type in the 
exact position in the background file where the overlay file is to be 
displayed. 

8. Snap button makes the overlaid files fit the background. This also 
resets the Overlay Positioning dialog settings and presents a new 
Scale factor. 

(Drag the Overlay and Compare dialog box to one side in order to 
see the result.) 

9. Scale button allow you to draw to lines, one on the background 
and one on the overlay. The overlay will be scaled in accordance 
with the difference in the length of the two lines. 

10. Move button makes the overlaid files fit the background by 
moving the overlay selecting two points. First select the 
background point then the point in the overlay that should be 
moved to the point on the background.  

11. Save stores the settings of the overlay or hybrid to a file with 
extension XWS (Rasterex Workspace) file. 

12. Select OK to confirm the overlay instructions, or Cancel to return 
to the active file window. 

13. To adjust or save the Overlay dialog, click the Compare and 
Overlay button again.  
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14. You can also visually scale and move overlay files by selecting 

the overlay using the Select Overlay button. 
 
This will highlight 

the overlay with a selection box around the edge of the overlay. 
You can then grab and move the overlay using the mouse. You 
can also scale the overlay by using the handlebars on the 
selection box. 

15. When an overlay is selected you can also directly edit the overlay 
properties in a separate overlay dialog by clicking on the Overlay 

Settings button . 

 

Figure 54 Overlay Selection dialog 

A Rasterex Workspace file contains the, coordinates, scaling and 
rotation of the overlay components. It can have the same name as the 
background file, but with the extension XWS. An XWS workspace file 
can be loaded using the drop-down arrow beside the Open button and 
selecting the item Overlay File.  

Note  The overlay function is useful for pictures and drawings. You 
cannot overlay spreadsheets and documents. 

 

13.2 Compare 
Drawing files can be compared to identify changes in a revision 
process. Typically, these files would be two revisions of a drawing and 
the comparison shows the differences between them. The differences 
are highlighted while identical features in the drawings are played 
down. 
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(Compare is a dynamic dialog. Changes to the comparison can be 
seen on screen as you work.) The result is displayed in a new window 
marked “Compare Window”. The settings applied to the comparison 
files can be saved and loaded. Load the saved compare settings file 
and you will re-create the compare as it was last saved. There is no 
limit to the number of compare files you can create.  

The process is similar to overlay, but compare files are best viewed in 
different mono-colors. 

Note  All files to be overlaid or compared must already be loaded 
before you open the Overlay dialog.  

The Document Overlay and Compare dialog shows a list box. The list 
box shows all the currently loaded files. Only one of these files can be 
selected as the background image the other files will be overlaid.  

 

How to compare files 

1. Load the files that you want to overlay or compare and then click 
the Compare Files button on the Home Ribbon > Overlay 
Compare Panel. 

2. In the Overlay and Compare dialog select a background file in the 
list box on the left. Click the Select document as: > Background 
radio button. 

The selected file is the background image. Only one file can be 
set as background. Background files have state “B”. 

3. Click the Display Mode > Compare radio button, and the 
background file is assigned a mono-color. 

4. Select the file to compare in the list box on the left. Click the 
Select document as: > Overlay radio button and the compare file 
is assigned a different mono-color. 

The selected file is marked as an overlay image. Even though 
you can have multiple overlay files, you will not normally use more 
than 2 files for comparison. Overlay files have state “O”. 
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The Display Color allows setting of colors. In Compare mode, the 
overlay file is displayed on top of the background file with an XOR 
function. This means that any differences between the two 
drawings are best displayed in a different color. In Compare 
mode, different Display Colors are automatically selected for the 
active files. Colors are assigned even if the drawings are normally 
displayed as monochrome using the Preferences dialog. 

5. The Display Mode is set to Compare.  

6. The Scale entry field allows you to type in an exact scale of the 
compare image in relation to the background image. This feature 
is not normally used in compare files, as they will be almost 
identical. 

7. Rotation allows a compare image to be rotated by selecting the 
desired angle of rotation, 0, 90, 180 and 270 in the Rotation field. 
This feature is not normally used in compare files, as they will be 
almost identical. 

8. The X-Offset and Y-Offset entry fields allow you to type in the 
exact position in the background file where the compare file is to 
be displayed. This feature is not normally used in compare files, 
as they will be almost identical. 

9. Snap to Background forces the overlaid files to fit to the 
background. This also resets the Overlay Positioning dialog 
settings and presents a new Scale factor. This feature is not 
normally used in compare files, as they will be almost identical. 

(Drag the Overlay and Compare dialog box to one side in order to 
see the result.) 

10. Scale button allow you to draw to lines, one on the background 
and one on the overlay. The overlay will be scaled in accordance 
with the difference in the length of the two lines. 

11. Move button makes the overlaid files fit the background by 
moving the overlay selecting two points. First select the 
background point then the point in the overlay that should be 
moved to the point on the background.  

12. Save stores the settings of the compare or hybrid to a file with 
extension XWS (Rasterex Workspace) file. 

13. Select OK to confirm the overlay instructions, or Cancel to return 
to the active file window. 
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14. To adjust or save the Compare dialog, click the Compare and 
Overlay button again.  

A Rasterex Workspace file contains the, coordinates, scaling and 
rotation of the compared components. It can have the same name as 
the background file, but with the extension XWS. An XWS workspace 
file can be loaded using the Open button and selecting the compare 
file with the extension XWS.  

Note  The compare function is most useful for drawings. You cannot 
compare spreadsheets and documents. 

 

 

13.3 XWS - Rasterex Workspace files 
Rasterex Workspace files contain the file references and settings for 
creating Overlay or Compare images.  

RxView can use older versions of XWS files created with RxHighlight 
97.  

XWS files created in RxViewX R9.1 and RxHighlight R12 cannot be 
read by RxHighlight 97 or RxView 97. All users should therefore 
upgrade to the same version of the software. 

You can have many Workspace files comparing different file revisions 
or overlay scenarios.  

Workspace files can be loaded, edited and re-saved with new file 
configurations and settings.  

If the participating files registered in the Rasterex Workspace file are 
not found ion their original locations, then the local folder from which 
the Rasterex Workspace file is opened is searched.  
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13.4 Save As (RxHighlight) 
Save As… RxView Button menu item and Convert button on Tools 
Ribbon > Conversion Panel allows you to save files in a different 
supported save format. You can save: 

 Raster files to supported raster formats. 

 Vector files to supported raster formats (Apply to CAD and Full 
versions only) 

 Vector files to supported vector formats (Apply to CAD and Full 
versions only) 

 Multipage documents to supported raster formats 

 Single page documents to supported raster formats 

 

 

Figure 55 Save dialog 

Save as type offers a dropdown list of available formats. Vector files 
do not have color or compression options. 

File name is the recommended file name with the extension of the 
selected format. 
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13.4.1 AutoCAD Convert 

This function apply to conversion between AutoCAD formats only. If 
you have opened an AutoCAD file in the viewer you can select this 
function to perform AutoCAD to AutoCAD native conversion. This 
conversion will keep the original AutoCAD entities. 

13.4.2 Saving to raster 

When saving to a raster format an additional dialog will appear to allow 
the user to select size, resolution and color options for the target raster 
file. 

 The following dialog is displayed: 

 

Figure 56 Save to raster file dialog 

Raster type offers a dropdown list of supported raster types or color 
depth for the selected format. As a rule, fewer bits create a smaller 
file.  
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Select image size group enables you to select the physical size of the 
image after it has been converted. Click on the arrow to open a list box 
of the available options. If you select Custom size, then the Size group 
becomes active and you can select the settings you require. Any other 
selection will apply preset values to the Custom size fields and 
maintain the original aspect ratio. Select a DPI value suitable for the 
type of image being generated. Be aware that this setting will 
dramatically affect the size of the resulting file.  

Size of file, if saved uncompressed indicates the size of the file that will 
result from converting the current file using the selected settings and 
WITHOUT compression. You can generate extremely large files if you 
create settings that are too large. Always check this field before 
clicking OK. 

Cancel returns to the Select Export Format and File Name dialog. 

OK complete the file save operation. 

 

13.4.3 Format Saving Options 

Options button, if available, give possibility to configure various 
settings that determine the properties of the target file. 

 

DWG and DXF 

  

Figure 57 DWG and DXF Save options 
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- Select AutoCAD version – Choose the AutoCAD format version 
for the target file.  

- File Type (DXF) – Choose binary or text DXF output.  

 

Acrobat PDF 

 

Figure 58 PDF Save options 

 

- Allow Use of Drawmode Operands – To support transparency 
and other advanced features this must be on for the target file to 
use them. For PDF/A 1B compatibility this must be turned off. 

- Allow PDF Layers – Allow saving of layers from the source files if 
supported to PDF layers. 

- Enable Large Format PDF Files – Allow the creation of large PDF 
files (90x90 meters). 

- Create PDF Markup – Make sure the markup in RxHighlight to be 
converted to markup compatible with Acrobat PDF. 

- Standard Selection – Select from PDF/A 1B or PDF/A 2B 
standards for the target file.  

- Compression – Compression to use on monochrome raster 
images embedded in the PDF document. 
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Tagged Image File Format 

 

 

Figure 59 TIFF Save options 

 

- Compression Type – Select between the supported compression 
formats. 

- Compression Type Color – Select between the supported 
compression formats for color target file. 

- Byte Order – Select between Motorola or Intel byte order. 
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Chapter 14 3D Drawing Files 

Apply to CAD and Full versions only. 

RxView allows viewing and markup of 3D files. Most 3D file formats 
require a separate license. 

 

14.1 3D Image File Functions 

14.1.1 Rotating a 3D Image 

14.1.1.1 The Rotate State Button 

Click the Rotate button on the CAD Ribbon > 3D Panel. 

The Rotate button enables you to rotate the image about its center 
point such that you can view the image from any direction. Place the 
Rotate cursor on the image. Click and hold down the left mouse 
button. Drag the mouse. 

Note  Hold down the CTRL, ALT or Shift keys on your keyboard as 
you drag the mouse to restrict the image to rotating about the X, Y or 
Z-axes. 

Note  While the Rotate State function is active, the three axes’ rotation 
angles are displayed in the Status bar. 

When the desired view is achieved, release the mouse button. 

The image will stop in the position it is in when you release the mouse 
button. The X, Y and Z-axes in the lower left corner of the file’s window 
indicate the current “direction” of the image view. 

Reset the image to its original view by clicking the Reset 3D Model 

button . 

14.1.1.2 Rotation Slider Dialog for 3D Files 

Select the Rotation Slider button 
 
on the Home Ribbon > View 

Panel. 
 
Three sliders are provided – one for each axis of rotation. 
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Figure 60 Rotation Slider dialog for 3D files 

Check the Update dynamically box to update the image in the window 
as you move the sliders. Drag the slider buttons to the desired rotation 
angle. You can also move the sliders in steps of 1° using the arrow 
keys.  Click Done or press ESC to close the dialog. 

14.1.2 Spinning a 3D Image 

The Spin function enables you to set the 3D image spinning continually 
about its center point, in any direction and at any speed. 

Click the Spin button  on the CAD Ribbon > 3D Panel to activate 

the function. 

Place the Spin cursor on the image. Click and hold the left mouse 
button. Drag the cursor across the image and release the mouse 
button while the mouse is still moving. 

The image will continue to rotate at the speed and in the direction that 
the cursor was moving when you released the mouse button. The X, Y 
and Z-axes in the lower left corner of the file’s window indicate the 
current “direction” of the image view. 

Note  Hold down the CTRL, ALT or Shift keys on your keyboard as 
you drag the image to restrict the image to spinning about the X, Y or 
Z-axes respectively. 
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Click the Reset 3D Model button  to return the image to its start 

position. The image will then recommence spinning in the same 
direction and at the same speed as it was before you clicked the reset 
button. 

To stop the image spinning, deselect the Toggle Spin View button. 

 

14.1.3 Display a 3D Image as Wireframe 

You can display an image as wireframe, i.e. remove the rendering, by 

clicking the Wireframe button  on the CAD Ribbon > 3D Panel. 

 

Figure 61  A 3D pyramid (left) displayed as wireframe (right) 
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14.1.4 Adding Perspective to a 3D Image 

Click the Perspective button  on the CAD Ribbon > 3D Panel to 

change a 3D image from a simple isometric view to a view with 
perspective. 

 

Figure 62  A 3D cube with perspective (left) and as a simple isometric view (right) 

14.1.5 Sectioning a 3D Image 

Using the sectioning functions available on the CAD Ribbon > 3D 
Panel, you can cut 3D images along planes such that you can see 
inside the object. You can use up to six cutting planes, each of which 
can be located in any position in the image and turned to any angle 
relative to the image. Once the cutting planes are in place you can 
rotate the image to any angle or set it spinning at any speed to achieve 
the desired view. 

You can save a sectioned image and reload it later so that you can 
return to the exact view. 

Note  The effects of sectioning may be more easily identified if the 
Options Dialog > Advanced > Show Image Extents option is toggled 
on. Use the sectioning functions as follows: 

To see the effects of sectioning as you perform the operation, click the 

Enable Cross-Sectioning button  on the CAD Ribbon > 3D Panel. 

To see the sectioning planes, click the Show Cross-Section Planes 

button . The planes are displayed in pale gray. 

To make a single cut as with a knife: 
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Click the Set Cross-Section button . Place the cursor where you 
want to start the cut, and click and hold the left mouse button. Drag the 
cursor to create the desired cutting plane, and then release the mouse 
button. The part of the image to one side of the cut will disappear. To 

see that part, click the Invert Cross-Section button . Use the Rotate 

function to turn the image to the desired view. 

To set up several cutting planes: 

Click the Set Cross-Section button . 

The Section Clipping dialog appears as shown in Figure 63. 

 

Figure 63 Section Clipping dialog 

Select a plane tab and then use the sliders to position that plane as 
required. Check Invert to see the other part of the image. 

Select other plane tabs as required and set them up. 

Note  The Enable Clipping and Show Plane boxes can be checked 
individually for each plane. 

Use the Rotate functions to turn the image to the desired view. 

To reset the image and remove any section planes, click the Reset 3D 

Model button . Click Reset to remove any changes made to the 
planes. 

Click Load to open a standard File Open dialog enabling you to load a 
previously saved Section Settings file. 

Click Save to open a standard Save As dialog enabling you to name 
and save the file with the current section settings. 
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14.1.6 Changing light and material properties 

The surface of rendered models can be set to different degrees of 
reflection and color. The color of the light reflected from the model can 
also be modified using the Material Settings dialog.  

  

 

Figure 64 Material Settings dialog 

The Material settings Dialog contain the following. 

Enable Materials – This item need to be checked for the different 
settings to take effect. 

Track Color – This item determine if only the color of the light is 
changed. Turn this off to change the color of the model surface itself. 

Ambient, Diffuse, Specular and Emission – Determine the color of 
the various light sources and reflections. 

Shininess – Drag slider to change the reflectiveness of the model 
surface. 

Dynamic Update – When checked the changes in the dialog will 
immediately be applied in the model without the need to close the 
dialog. 

 



 

 

169 

14.2 3D Block functions 
Open the block list bar to manipulate individual 3D parts. The Block 
List Bar is one of the workspace panes available in the upper left 
corner of the workspace. If hidden you can click on the Block button to 
display it. The tree structure in this Pane enables you to toggle each 
3D block individually.  

 

 

Figure 65 Block list 

14.2.1 Changing the transparency for a block 

Right click on a specific block in the list to bring up the block list 
context menu. Select Transparency from the context menu to change 
the transparency for the selected block. This will open the Block 
Transparency dialog. 
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Figure 66 Block Transparency dialog 

Use the slider to set the transparency level of the block. 

  

Figure 67 Setting block transparency  

14.2.2 Changing the color of a block 

Select color from the block list context menu to change the display 
color on individual blocks. 
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Figure 68 Block color dialog 

 

  

Figure 69 Setting block color 
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Chapter 15 Markup Dialogs and Editing 

If you have the RxHighlight markup plugin loaded and enabled, you will 
be able to make markups on any file that you can open in RxView. 

 

15.1 Markups 
RxHighlight allows markup directly on top of a file. Unlimited different 
colors and unlimited different layers are available. By turning markup 
layers on and off, markups written by different commentators can 
easily be isolated and viewed separately. Markups are stored in vector 
files separate from the original file. The markup files can be either one 
single file (extension .XCM as default) or multiple files - one for each 
commentator. 

15.1.1 Markups in Multiple Files 

The first markup file has the same name as the viewed file but with the 
extension .000 or .X00. The next markup file has the extension .001 or 
X01 and so on. The maximum number of commentators, each with 
different stored markups, is 1000 or 360 depending on the selected 
extension type. 

15.1.2 Markups in a Single File 

The markup file has the same name as the viewed file but with the 
default extension .XCM. The number of commentators allowed, each 
with different stored markups, is unlimited. 

A variant of the single file name convention is to use the original file 
name and extension with the XCM added as a second extension. Ex. 
Myfile.tif.xcm 

15.1.3 Markup Policy 

To avoid internal conflicts, an organization should define either a 
single or multiple markup file policy, as single markup files cannot be 
read and maintained simultaneously by different users. Administrators 
and programmers can implement advanced markup control.  
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15.1.4 Compatibility with Earlier Markup Files 

The following rules apply for creating and viewing existing markups 
created in RxView and RxViewX. 

Important Markup compatibility rules for backwards compatibility: 

15. RxHighlight R12 can read markup files created by RxHighlight 
R5-R9, RxHighX R5-R9, RxHighlight 97 and RxHighX 97. 

16. Previous versions of RxHighlight or RxHighX cannot read Markup 
files created in RxHighlight R12. All users should therefore 
upgrade to the same version of the markup software. 

17. To read markup files, both 32-bit and 16-bit RxHighlight must 
have the correct markup file extension type. These are set in the 
Options > Preferences dialog for 16-bit RxHighlight, and in the 
Comment > Preferences dialog for 32-bit version. 

18. 32-bit RxHighlight can only read markups created in 16-bit 
RxHighlight. 

19. 16-bit RxHighlight cannot read markups created or modified in 
32-bit RxHighlight. 

20. XCM markup files can only be created and viewed in 32-bit 
RxHighlight. 

21. 32-bit RxHighlight will always read XLK files, i.e. 16-bit 
RxHighlight link files. 

22. Do not rename 16-bit markup files as XCM files. 32-bit 
RxHighlight will not be able to read them. 

15.2 Document Linking 
Links are stored together with markups in the same file(s).  

You may link files to each other. In other applications this feature is 
often called “Hyper-linking”. When you click on a comment that 
contains a hyperlink, the corresponding file is loaded. You can specify 
a hyperlink for most comment types. 
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15.3 Markup Preferences Dialog 
Click the Markup button on the Settings Ribbon > Settings Panel. This 
dialog holds three tabs; the General tab, File tab and Advanced tab. 

15.3.1 General Tab 

Use this dialog to control general markup features and options. 

 

Figure 70 Markup Preferences General Tab 

Layer 

The name of the selected markup layer. All markups are written in this 
layer. If the layer is changed, the new markups are written in the new 
current layer. Layer information is shown in a popup text when you 
hold the mouse over a markup. 

Color 

The markup color used by the current markup layer. All markups on 
the layer are written in this color. If the color is changed, the color of 
previous markups on this layer is unchanged but new markups are 
written in the new current color. 

Line Width 

Line thickness for the markups in this markup layer. 
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Rubber Width: 

Rubber thickness for the rubber markups. 

Text Font 

The font to be used in text markups. Click the Font button to open a 
font selection dialog. New text markups are written in the new font and 
size. 

Measurement Font 

The font to be used for measurement markups. Click the Font button 
to open a font selection dialog. New measurement markups are 
written in the new font and size. 

Apply all above changes to all current markups  

New markups will always be created using the currently selected color 
and layer. However, if existing markups were created in different 
colors or layers, you can change all markups to the current color, layer 
and user by checking this item and pressing the Apply button. The 
changes will only be made to the active file. 

Note This is a powerful command without an undo function. If you 

need to restore the original markup, then close the file and do NOT 

save the markup changes that are offered on exiting.  
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Line width and text size are in 

Absolute document units - The line width selected in the Markup 
Toolbar is relative to the active document's size. A thin markup line on 
a large document (for example an A0 format drawing) may not be 
visible on the screen. 

Current display units - The line width selected in Markup Toolbar is 
relative to the display size. Typically, a markup line visible on the 
screen for a large document (for example an A0 format drawing) will 
be thick when the document is printed or plotted. 

 

15.3.2 File Tab 

Use this dialog to control the type of markup storage file and the 
location of the markup file. 

 

Figure 71 Markup Preferences File Tab 
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Markup file type 

Single file (XCM) - Markups are saved in a single file that contains the 
markups from all the users. The default Single file extension is .XCM. 

000 - 999 files - Markups are saved in multiple files, one file for each 
commentator. The files are saved sequentially in the range 000 - 999. 

X00 - XZZ files - Markups are saved in multiple files, one file for each 
commentator. The files are saved sequentially in the range X00 - X9Z. 

Single file extension 

When you select Single file (XCM) as the Markup file type, the XCM 
file extension is added as default. However you can save the markup 
file as any type of file by typing in the appropriate file extension. 

Markup folder type 

You can select in which folder you wish the markup file to be saved: 

Same as viewed file - The markup file is saved in the same folder as 
the image file to which it is attached. 

Subfolder to viewed file - The markup file is saved in a subfolder to 
the folder in which the image file is located. Type the name of the 
required subfolder into the Folder or Subfolder field. 

Separate Markup folder - The markup file is saved in an entirely 
separate folder to that in which the image file is located. Type the full 
path and name of the required folder into the Folder or Subfolder field. 

Folder or subfolder 

If you have selected to save the markup file in a subfolder to the image 
file folder, or in an entirely separate folder, then browse to the folder or 
type the path and name of the required markup folder into this data 
field as described above. 

 

Markup Auto Save 

Set Markup Auto Save on/off and set save interval in minutes. 

 

15.3.3 Advanced Tab 

Under the advanced tab you can set additional markup options to 
control the look and behavior of the markup functions. 
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Figure 72 Markup Preferences Advanced Tab 

Display 

 Display monochrome markup if drawing is monochrome – 
This setting will make markup associated with the current 
drawing display as monochrome if the drawing format has the 
monochrome display setting on. 

 Show markup information tool tips – If checked, RxHighlight 
will display information about the markup entity under the 
mouse cursor. 

 Hide Measurement Text – This option will hide measurement 
text associated with measurement entities. 

 Unframed Transparent Measure text – This option will make 
the text for area measurement entities transparent and 
unframed. 

 Include Perimeter for Area Measurements – This option will 
add an additional Perimeter text for area measurement 
entities. 
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 Include Volume for Area Measurement – This option will 
include Volume in markup list and area measurement text 
when a height is set for the area markup. 

 Rotate Measure Text – When on, text associated with 
dimension entities will rotate with the dimension entity. 

Save 

 Always save markup on exit – If checked, RxHighlight will 
save any markups created or changed without prompting the 
user when closing the application. 

 Create RML copy when saving markup - This option will 
automatically create an RML copy of the current redline file 
every time you save your comments. 

Edit 

 Stay in add markup mode after drawing markup entity – 
This setting will ensure that the user can keep adding the 
selected markup entity to the drawing and not switch to edit 
mode after each inserted markup. 

 Use Revcloud style for bubble entities – This option will 
create revcloud style bubble entities when adding bubble 
markup entities to the drawing.  

 

Dimension Line Defaults 

Dimension line text placement 

On – places the text directly on the dimension line. 

Above – places the text above the dimension line. 

Below – places the text below the dimension line. 

Dimension line terminators – Controls the type of dimension line 
terminators used. Select between Filled arrow, Arrows, Circles 
and Lines. 

Export 

Use text entities in exported markup files – This option will create 
text entities in the RML markup file so that markup text entities can be 
edited as text when they are imported into AutoCAD. 
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15.3.4 User Control Dialog 

Click the User Control button  on the Markup Ribbon > Tools 

Panel. 

Use this dialog for an overview of users and markups. Turn On and 
Off markups written by different users, and delete users. 

 

Figure 73 Markup User Control dialog. 

The dialog comprises a list box where each line represents a user with 
his or her signature, and On or Off indicating whether the respective 
user's markups are currently turned on or off. This is a dynamic control 
so you can see the changes on screen when you toggle or delete 
users.  

15.3.4.1  To Turn Users On and Off 

23. Using standard Windows techniques select one or more users in 
the list box. 

24. Click On, Off or Toggle as appropriate to turn the selected user's 
markups on or off. 

25. Click Close to close the dialog. 
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15.3.4.2  To Delete Users 

26. Using standard Windows techniques select one or more users in 
the list box. 

27. Click Del to delete the selected users and their markups - this 
operation removes all the selected markups. 

28. Click OK to confirm deletion, or Cancel to restore the deletion. 

 

Warning! Deleting other users’ markups is an irreversible 

command. If you are in doubt then click Cancel. 

 

Note  Your User Profile determines whether you can delete other 
user's markups. In an organization this will be a restricted command. 
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15.3.5 Layer Control Dialog 

Click the Layer Control button  on the Markup Ribbon > Tools 

Panel. 

The dialog comprises a list box where each line represents a Markup 
layer, and On or Off indicating whether the markup layer is currently 
turned on or off. This is a dynamic control so you can see the changes 
on screen when you toggle layers.  

 

Figure 74 Markup Layer Control dialog. 

15.3.5.1 To Turn Layers On and Off 

1. Using standard Windows techniques select one or more layers in 
the list box. 

2. Click On, Off or Toggle as appropriate to turn the selected 
markup layers on or off. 

3. Click Close to close the dialog. 
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15.4 Editing Markups 

15.4.1 Rules 

1. Only the owner of the Markup can edit it.  

2. The current user must own the markup in order to edit it. The 
current user is the person logged into RxView. 

3. To change the current user click the Signature button on the status 

bar  and write the new user’s name in the Enter Logon 

Information Dialog. The user name is case-sensitive. 

4. User information is stored in the markup file. If a user signature is 
changed you may be asked to save the markup file. 

 

15.4.2 Selecting markups 

1. Click the  Edit button on the Markup Ribbon > Edit Panel. 

2. Click a markup. If you are not the owner then you cannot edit the 
markup. If you own the markup then it will be selected. A selection 
is enclosed by a black selection frame, with one or more small 
buttons or handles.  

3.  Click outside the selection to de-select.  

.  

15.4.3 Editing markups 

The editing controls depend on the type of markup. 

 Move a markup by placing the cursor inside the markup selection and 

clicking the left mouse button. The cursor changes from an arrow to a 
hand. Press and hold down the left mouse button, and drag the 
markup to the desired position. Click outside the line to de-select. 

 Zoom or size a markup by placing the cursor on the  button. The 
cursor changes to a finger. The markup is scaled by holding down the 
left mouse button and dragging the corner of the markup. Click outside 
the line to de-select.  
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 Rotate a markup by placing the cursor on the  button. The cursor 
changes to a finger. The markup is rotated by holding down the left 
mouse button and dragging the corner of the markup. Click outside the 
line to de-select.  

 Control button on a selected line, arrow or dimension offers Drag and 

Scale buttons on the markup. Place the cursor on the  button. The 
cursor changes to a finger. Click to access the grip buttons.  

 Drag and scale a markup line, arrow or dimension by placing the 

cursor on the  button. Hold down the left mouse button and drag to 
move or change the length of a line. Click outside the line to de-select. 

 Drag and scale a curve by placing the cursor on the  button. Hold 
down the left mouse button and drag to move or change the length of 
a curve. Click outside the curve to de-select. 

 

 Right mouse button menu   
Click the right mouse button to show other options. 

 

Figure 75 Markup Right mouse button menu 

Edit allows you to edit the selected markup. The available options may 
vary depending on the type of markup object you have selected. 
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Edit Points allows you to edit points in markup objects that consist of 
polylines or splines. 

Copy create a copy of the selected markup object. 

Delete allows you to delete the selected markup.  

Bring to Front allows you to move a markup to the front. 

Push Back allows you to move a markup to the back. 

Marker set the marker mode on for the selected markup object. 

Outlined, Filled, Edged and Hatched will change the fill style of the 
selected markup object. 

 

15.5 Markup Edit dialog 
Edit presents an edit dialog specific for the markup object selected. 
The below dialog show the edit dialog for area measurement markups. 

 

Figure 76 Markup Edit dialog 

The options presented in the Markup Edit dialog are described 
throughout this and the previous sections. 

Changes to markups are not permanent unless the Markup file is 
saved. Most comments can also contain a hyperlink to another file. 
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You can select a file that you want to use as a hyperlink by clicking on 
the browse button next to the Hyperlink field. You can also type in an 
URL in this field directly. 

15.6 Editing Links 
Link buttons can be edited and the link directed to a different file 
through the Select Link File dialog. 

15.7 Editing Notes 
The editing dialog for Notes are the same as used to create them. 

15.8 Editing Text 
The text markup edit dialog allows you to change the properties of the 
text markup object. 

 

Figure 77 Text Markup Edit dialog 
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15.9  Editing Other markup entities 
The editing dialog for Lines, Curves, Rectangles, Circles, Arrows and 
other markup entities allow you to change the properties specific to 
that particular object. 

 

Figure 78 Rectangle Markup Edit dialog 

In the above example the rectangle markup entity has a markup layer, 
fill style, hatch style, rotation, line width and hyperlink property that can 
be changed from the markup edit dialog.  

15.10 Consolidation 
Markup entities and comments from multiple users can be transferred 
to a user with special privileges using the RxHighlight consolidation 
functions. These functions are only available if the following 
requirements are met. 

 Comment files that contain markup entities from more than 
one user must be opened with the main file. 

 The current user must have administrator privileges. 

 

There are several approaches to do markup consolidation. 
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15.10.1 Users and layers 

Click on the Consolidate button on the Markup Ribbon > Tools Panel 
to open the Consolidate layers dialog. 

 

Figure 79 Consolidate Layers dialog 

Select the available user signatures from those available in the list and 
click on the Consolidate button to transfer all the markup entities from 
the selected users to the current administrator user. Some additional 
options exist that modify the behavior of the Consolidate function. 

Keep original entity layer – Will place the transferred markup entities 
without changing the layer they are currently on. If unchecked you can 
choose a new layer to place the markup entity on. 

Keep original entity color – Will keep the markup color on the  
transferred markup entity. If unchecked a new color can be applied to 
the markup entity. 

Action to Perform on Picked Entity – Choose to Delete, Hide or 
keep the original entity after consolidation. 
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Copy entity to selected layer – Will transfer the markup entities from 
the selected users to a specific markup layer. This requires that the 
Keep original entity layer is turned off. 

15.10.2 Pick Entities 

Select the Pick Entities menu item from the Markup Ribbon > Tools 
Panel Consolidation button drop down menu. This function will enable 
the user to pick individual markup entities using the mouse and 
transfer them to the current administrator user. The behavior of the 
Pick Entities function is controlled by the Pick Options function.  

15.10.3 Pick Options 

Select Pick Options from the Consolidation sub menu on the Markup 
menu to open the Consolidate layers dialog. 

 

Figure 80 Consolidation Options 

Keep original entity layer – Will place the transferred markup entities 
without changing the layer they are currently on. If unchecked you can 
choose a new layer to place the markup entity on. 

Keep original entity color – Will keep the markup color on the  
transferred markup entity. If unchecked a new color can be applied to 
the markup entity. 

Action to Perform on Picked Entity – Choose to Delete, Hide or 
keep the original entity after consolidation. 
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15.11 Stamps dialog 
The stamps dialog is displayed when you select the markup stamps 
button on the Markup Ribbon > Draw Panel. 

Use stamps to insert a predefined stamp as a markup entity for the 
current drawing. 

Click on the Insert Stamp button in this dialog to insert the selected 
stamp with the selected options. 

 

Figure 81 Stamp dialog 

Stamp Options – You can optionally include dynamic content as text 
in the stamp. 

Include User Name – Includes the user signature in the stamp. 

Include Date – Includes the current date in the stamp. 

Upper Case – Set upper case on all text in the stamp. 

Include time – Includes current time in the stamp. 

Custom Text – Includes a custom text in the stamp. 
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Text color – The color used for the text in the stamp. 

Fill color – The color used for the background fill in the stamp if the 
Fill Background check box is checked. 

 

15.11.1 Stamp menu 

The stamp button has a drop down menu as shown below. 

 

Figure 82 Stamp menu 

Use the first 6 menu items to insert a pre-defined stamp. 

 

Custom Stamps 

If any Custom Stamps are defined you can insert them from this sub 
menu. 
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Define Custom Stamps 

Opens a dialog that allow you to define custom stamps. 

 

Figure 83 Custom Stamp dialog. 

Custom number list - Corresponds to the Custom Stamp sub menu 
item on the Stamp menu. 

Include User Name – Includes the user signature in the stamp. 

Include Date – Includes the current date in the stamp. 

Include time – Includes current time in the stamp. 

Upper Case – Set upper case on all text in the stamp. 

Text color – The color used for the text in the stamp. 

Fill color – The color used for the background fill in the stamp if the 
Fill Background check box is checked. 

Height – Define the height of the stamp in mm relative to the current 
file. 

Custom Text – The Custom Stamp text. 

Stamp Name – The name of the Custom Stamp that appear on the 
Custom Stamps sub menu. 
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Chapter 16 Configuring RxView 

 

 

The configuration program is used to set up the users rights and other 
user configuration data. It stores this information in a configuration file. 

 The RxView/RxHighlight Configuration program utility is installed 
automatically. Use it to allocate names to the various markup layers in 
RxHighlight, and to set up User Profiles. 

 

Login is controlled through a username and password.  By using the 
configuration program multiple users can access the RxView and 
markups from the same computer irrespective of the Windows 
username. If the user does not login using a user name and password, 
the Windows login username is used to identify the current user. 

 

16.1 Network Administrators! 
Study this chapter carefully and use the Configuration program utility to 
control permissions for users in a network. By using the User Profile 
concept within RxHighlight and RxView, organizations can control the 
viewing (and markup) procedures within the company. Each user will 
have his or her personal User Profile set up by the administrator, 
defining privileges and limitations. 

16.1.1 Markup 

RxHighlight allows annotating of file contents by adding graphics and 
text into markup layers. Markups are stored in separate vector files. 
Files can have multiple markup layers created by separate 
commentators. 
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16.1.2 Linking 

RxHighlight allows link-related files. The link function creates buttons 
on top of the viewed file that connect with other files. Clicking a link 
button loads the linked file. Links are an integral part of markup layers 
and do not require any special configuration. 

16.1.3 User Profile Setup 

In a multi-user environment, User Profiles are set up to control 
creation, viewing, editing and deleting of markups, and permissions for 
operations such as, editing applications and printing. This 
administrative tool gives full control of user rights. 
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16.2 RxHighlight/RxView Configuration Options 
Using the Windows Start menu, open the RxHighlight Configuration 
program utility. The default path is: 

Start > Programs > Rasterex > RxView > User Configuration 

The following screen appears: 

 

Figure 84 Configuration Manager 

16.2.1 Network Administrators! 

Restrict access to the Configuration program to administrators only, 
and do not distribute the configuration program to individual users. By 
using the User Profile concept, you can maintain full control over the 
viewing and commenting procedures within the organization. 

16.2.2 Single Users 

If you are a Single User and not connected to a network, there is no 
need for a User Profile, as you will have all privileges anyway. 
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16.2.3 Network Users 

On starting RxView / RxHighlight for the first time, you may be asked 
to type in your signature. If this signature matches a signature in the 
existing User Profile (see above), the privileges determined by the 
User Profile will automatically be validated. If there is no match 
between signatures, a default profile is loaded. 

16.2.4 Configuring 

1. Set the path to the disk folder in which the file RXCONV.XCF is to 
be saved, by typing the path in the Configuration File Directory 
entry field. The default value is the Components folder under 
Common Files\Rasterex Shared. 

2. Click on the Groups button to add or edit user groups. 

3. Click on the Users button to add and edit user profiles. 

4. Click the Markup Layers button and name and set colors for the 
markup layers required. See paragraph Markup Layer Setup 

5. Click on the Settings button and select the Markup tab to set the 
number of layers. 

Note  Set Markup layers before User profiles. 

6. In the User Manager dialog, select a user and click the Edit button 
to assign a user profile to each RxHighlight/RxView user. See 
paragraph User Profile Setup. 

7. Click Save to save the configuration in the file RXCONV.XCF. 
Click Close to cancel. 

Note Users and layers are controlled in a 2-dimensional array. If 
memory requirements are exceeded, an “Out of memory” warning will 
be presented. Reduce the numbers of layers and users to fit the 
memory. You can change the number of users and layers at any time 
without damaging existing markups. As a rough guide, each user 
requires 16KB, i.e. 1000 users in a 16MB RXCONF.XCF. 
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16.3 Markup Layer Setup 
Click the Markup Layer button. The dialog shown below appears: 

 

Figure 85 Setup of Markup Layers dialog 

1. Type the required layer name into the Layer name entry field. 

2. Select a Layer color for the layer. 

3. Edit any name by selecting it from the List of Layer Names. 

4. Click Cancel to cancel session changes. 
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16.4 User Profile Setup 
For RxHighlight and RxView users, the User Profile determines 
whether you will be allowed to: 

Open files. 

Close files. 

Edit file contents. 

Print files. 

For RxHighlight users, the User Profile also determines what you will 
be allowed to do with markups. 

 

Figure 86 User Profile Setup – Markup tab 

On the Markup tab enter the default markup layer in the Default layer 
entry field. 

On the Files tab select the file operations the user should be allowed 
to perform by checking the required options. 

On the Application tab select the Application functions the user should 
be allowed to perform by checking the required options. 
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Note  The Save Settings to Default User check box is made to ease 
the management of multiple installations on a network. This function 
retains the current settings so they can be used as the default for later 
installations. This enables other users to simply copy the default 
settings made by the administrator. If a user has already installed the 
program and the administrator later checks this box for the user, the 
next time the user starts the program it will adopt the default settings 
set by the administrator. 

 

Repeat the procedure for each user or group of users. 

 

If you have defined and selected a group and checked the Use Group 
Settings check box, then the settings for that group will be used. 

 

Note  The Change markup layer option defines whether a user can 
use other layers than the default markup layer. 
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16.4.1 Setting Markup Layers 

 

Figure 87 User Profile Setup – Markup Layers tab 

On the Markup layers tab set the markup layers that the user is 
allowed to view.  

 

Repeat the procedure for each user or group of users. 



 

 

202 

Saving Configuration Data 

When exiting the configuration program remember to save the 
configuration changes. 
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Chapter 17 Convert command line parameters 

Conversion require a separate conversion license. 

Following parameters are available: 

                  

/cr format width height bitsperpixel dpi inputfile outputfile 

 format: BMP, CALS, CIT, DWF, JPEG,  HPRTL, PDF, PNG or 
TIFF 

 width: width of raster image in pixels 

 height: height of raster image in pixels 

 dpi:  dots per pixel 

                 

 /cv format inputfile outputfile 

 format: CGM, DGN, DWF, DWG, DXF, HPGL, PDF or SVG 

                                

 /cvs  format upi inputfile outputfile 

 formats : same as /cv 

 upi : Unit per inch for scaling between source and destination 
file.                               

         

 



 

 

204 

Chapter 18 Supported File Formats 

Check the Rasterex web for latest file format support list. 

 

Rasterex Windows 32-bit filters are named RxFilter_*.DLL. 

The * indicates where a file extension identifier will appear; for 
example RxFilter_DWG.DLL for the AutoCAD DWG file filter. 

 

Filters may be supplied as self-installing executables. Simple execute 
the file to update your filter. 
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